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เกี่ยวกับคูมือนี้

คำเตือน! ขอความในลักษณะนี้หมายถึงการไมปฏิบัติตามอาจเปนผลใหเกิดการบาดเจ็บหรือเสียชีวิต

ขอควรระวัง ขอความในลักษณะน้ีหมายถึงการไมปฏิบัติตามอาจเปนผลใหเกิดความเสียหายตออุปกรณหรือสูญ
เสียขอมูล

หมายเหตุ ขอความที่ปรากฏในลักษณะน้ีหมายถึงขอมูลเพิ่มเติมที่สำคัญ
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1 คุณสมบัติการวินิจฉัยระบบคอมพิวเตอร

HP Insight Diagnostics
หมายเหตุ HP Insight Diagnostics จะรวมอยูในแผนซีดีที่จัดสงไปพรอมกับคอมพิวเตอรบางรุน

ยูทิลิตี HP Insight Diagnostics ชวยใหคุณสามารถดูขอมูลเกี่ยวกับการกำหนดคาฮารดแวรของคอมพิวเตอร และทำการ
ทดสอบวินิจฉัยฮารดแวรในระบบยอยของคอมพิวเตอร ยูทิลิตีนี้จะชวยใหขั้นตอนการระบุอยางมีประสิทธิภาพ การวินิจฉัย
และการแยกปญหาฮารดแวร กระทำไดงายขึ้น

แท็บ Survey จะแสดงข้ึนเมื่อคุณเรียกใชยูทิลิต ีHP Insight Diagnostics แท็บนี้จะแสดงการกำหนดคาปจจุบันของ
คอมพิวเตอร จากแท็บ Survey จะสามารถเขาสูประเภทขอมูลหลายกลุมเก่ียวกับคอมพิวเตอรนั้น แท็บอ่ืนๆ จะใหขอมูลเพ่ิม
เติม รวมถึงตวัเลือกการทดสอบวินิจฉัยและผลลัพธการทดสอบ ขอมูลในแตละหนาจอของยูทิลิตีจะสามารถบันทึกเปนไฟล
html และจัดเก็บลงในดิสเก็ตตหรือ USB HP Drive Key ได

ใช HP Insight Diagnostics เพื่อตรวจสอบวาอุปกรณทั้งหมดที่ติดตั้งในระบบคอมพิวเตอรมีการรับรูภายในระบบและทำ
งานอยางถูกตอง การรันการทดสอบเปนสิ่งที่คุณเลือกปฏิบัติได แตขอแนะนำใหคุณกระทำทุกครั้งที่ติดต้ังหรือเชื่อมตอ
อุปกรณใหม

คุณควรทำการทดสอบ บันทึกผลการทดสอบ และพิมพออกมาเพื่อใหมีรายงานฉบับพิมพพรอมอยูกอนที่จะติดตอฝายบริการ
สนับสนุนลูกคา

หมายเหตุ HP Insight Diagnostics อาจตรวจไมพบอุปกรณของบริษัทอ่ืน

การเขาใช HP Insight Diagnostics
คุณตองบูต แผนซีดี Documentation and Diagnostics ตามขั้นตอนที่ระบุไวดานลางน้ี เพ่ือเขาใชงาน HP Insight
Diagnostics

1. ขณะที่คอมพิวเตอรเปดอยู ใหใส แผนซีดี Documentation and Diagnostics ลงในไดรฟออปติคัลของคอมพิวเตอร

2. ปดระบบปฏิบัติการและปดเคร่ืองคอมพิวเตอร

3. เปดเคร่ืองคอมพิวเตอร ระบบจะบูตจากแผนซีดี

หมายเหตุ หากระบบไมบูตจากแผนซีดีในไดรฟออปติคัล ทานอาจจำเปนตองเปล่ียนลำดับการบูตในยูทิลิตี
การต้ังคาคอมพิวเตอร (F10) เพื่อใหระบบพยายามบูตจากไดรฟออปติคัลกอนบูตจากฮารดไดรฟ โปรดดูราย
ละเอียดเพิ่มเติมใน คูมือยูทิลิตีการตั้งคาคอมพิวเตอร (F10) ใน แผนซีดี Documentation and
Diagnostics

คุณยังสามารถเปลี่ยนลำดับการบูตเคร่ืองเพ่ือใหระบบบูตไปที่ไดรฟออปติคัลในแตละคร้ังไดดวยการกดปุม F9
เม่ือเร่ิมตน

4. เลือกภาษาที่เหมาะสม และคลิก Continue
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หมายเหตุ ขอแนะนำใหคุณยอมรับแปนพิมพตามที่กำหนดเปนคาดีฟอลตสำหรับภาษาของคุณ เวนแตคุณจะ
ตองการทดสอบแปนพิมพเฉพาะ

5. ในหนา ขอตกลงเรื่องการอนุญาตใชสำหรับผูใช คลิกที่ Agree หากคุณยินยอมในเง่ือนไข ยูทิลิตี HP Insight
Diagnostics จะถูกเรียกทำงานพรอมกับมีแท็บ Survey แสดงขึ้น

แท็บ Survey
แท็บ Survey จะแสดงขอมูลการกำหนดคาสำคัญของระบบ

ในสวน View level คุณสามารถเลือกมุมมอง Summary เพ่ือดูขอมูลการกำหนดคาบางอยาง หรือเลือกมุมมอง
Advanced เพ่ือดูขอมูลทั้งหมดในประเภทที่เลือก

ในสวน Category คุณสามารถเลือกใหแสดงผลขอมูลตอไปน้ี:

All - แสดงรายการประเภทขอมูลหลายกลุมเก่ียวกับคอมพิวเตอรนั้น

Overview - แสดงรายการขอมูลทั่วไปเก่ียวกับคอมพิวเตอรของคุณ

สถาปตยกรรม - ใหขอมูล BIOS ระบบ และอุปกรณ PCI

Asset Control – แสดงช่ือผลิตภัณฑ แท็กสินทรัพย หมายเลขซีเรียลระบบ และขอมูลโปรเซสเซอร

Communication – แสดงขอมูลเกี่ยวกับการตั้งคาพอรตขนาน (LPT) และพอรตอนุกรม (COM) ของคอมพิวเตอร รวม
ถึงขอมูลเน็ตเวิรกคอนโทรลเลอร และ USB

Graphics – แสดงขอมูลเกี่ยวกับคอนโทรลเลอรแสดงผลกราฟกของคอมพิวเตอร

Input Devices - แสดงขอมูลเกี่ยวกับแปนพิมพ เมาส และอุปกรณอินพุทอื่นๆ

Memory - แสดงขอมูลเก่ียวกับหนวยความจำในคอมพิวเตอร ซ่ึงรวมถึงสล็อตหนวยความจำบนเมนบอรดและโมดูลหนวย
ความจำที่ติดตั้ง

Miscellaneous – แสดงขอมูลรุนของ HP Insight Diagnostics ขอมูลหนวยความจำการกำหนดคาคอมพิวเตอร
(CMOS) ขอมูลเมนบอรด และขอมูล BIOS การจัดการระบบ

Storage - แสดงขอมูลเกี่ยวกับส่ือจดัเก็บขอมูลท่ีเชื่อมตอกับคอมพิวเตอร ซ่ึงรวมถึงดิสกทั้งหมดที่ติดตั้ง ดิสเก็ตตไดรฟ
และไดรฟออปติคัล

System – แสดงขอมูลเกี่ยวกับรุนของคอมพิวเตอร โปรเซสเซอร โครงเคร่ือง และ BIOS รวมถึงลำโพงภายในและขอมูล
บัส PCI

แท็บ Test
แท็บ Test ชวยใหคุณสามารถเลือกทดสอบสวนตางๆ ของระบบได อีกทั้งสามารถเลือกประเภทและโหมดของการทดสอบได

โหมดการทดสอบมีใหเลือกสองโหมดคือ:

● Quick Test - แสดงสคริปตที่กำหนดไวลวงหนา เม่ือมีการทดสอบตัวอยางของสวนประกอบฮารดแวรแตละชิ้น และ
ไมตองการการแทรกแซงจากผูใช ไมวาในโหมด Unattended หรือ Interactive

● Complete Test – แสดงสคริปตที่กำหนดไวลวงหนา โดยที่สวนประกอบฮารดแวรแตละชิ้นจะถูกทดสอบอยางเต็มที่
ยังมีการทดสอบอีกหลายแบบใหเลือกไดในโหมด Interactive แตจำเปนตองไดรับการแทรกแซงจากผูใช

● Custom Test - ใหความยืดหยุนมากที่สุดสำหรับการควบคุมการทดสอบระบบ โหมด Custom Test ชวยใหคุณ
สามารถเลือกอุปกรณ การทดสอบ และพารามิเตอรการทดสอบที่จะใช ไดเปนการเฉพาะ
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โหมดการทดสอบมีใหเลือกสองโหมดสำหรับการทดสอบแตละประเภท:

● Interactive Mode – ใหการควบคุมขั้นตอนการทดสอบไดสูงสุด ซอฟตแวรวินิจฉัยจะใหคุณปอนขอมูลระหวางการ
ทดสอบท่ีตองการการตอบสนองจากคุณ คุณยังอาจตรวจสอบไดวาการทดสอบน้ันผานหรือไมผาน

● Unattended Mode - ไมแสดงการแจงและไมตองการขอมูลจากคุณ ในกรณีที่พบขอผิดพลาด จะปรากฏขอความ
ระบุถึงขอผิดพลาดหลังจากที่การทดสอบเสร็จสิ้นลง

ในการเริ่มตนการทดสอบ:

1. เลือกแท็บ Test

2. เลือกแท็บชนิดของการทดสอบที่คุณตองการรัน: Quick, Complete หรือ Custom

3. เลือก Test Mode: Interactive หรือ Unattended

4. เลือกวิธีการสั่งการทดสอบที่คุณตอง โดยมีแบบ Number of Loops หรือ Total Test Time เม่ือเลือกรันการทด
สอบตามลำดับการวนที่ระบ ุใหปอนจำนวนการวนที่จะดำเนินการ หากคุณตองการใหการวินิจฉัยทดสอบตามชวงเวลาที่
ระบุ ใหปอนจำนวนเวลาเปนนาที

5. หากคุณเลือกทำการทดสอบแบบ Quick Test หรือ Complete Test ใหเลือกอุปกรณที่ตองการทดสอบจากรายการ
ดรอปดาวน หากคุณเลือกทำการทดสอบแบบ Custom Test ใหคลิกปุม Expand และเลือกอุปกรณที่ตองการทด
สอบ หรือคลิกปุม Check All เพื่อเลือกอุปกรณทั้งหมด

6. คลิกปุม Begin Testing ที่มุมขวาลางของหนาจอเพ่ือเร่ิมตนการทดสอบ แท็บ Status ซึ่งชวยใหคุณตรวจดูความคืบ
หนาของการทดสอบ จะแสดงขึ้นโดยอัตโนมัติระหวางข้ันตอนการทดสอบ เม่ือการทดสอบเสร็จสิ้น แท็บ Status จะ
แสดงวาอุปกรณผานหรือไมผาน

7. หากตรวจพบขอผิดพลาด ใหไปที่แท็บ Log และคลิกที่ Error Log เพ่ือแสดงขอมูลเพ่ิมเติมโดยละเอียดและมาตรการ
ที่แนะนำ

แท็บ Status
แท็บ Status จะแสดงสถานะของการทดสอบที่เลือก ประเภทของการทดสอบที่ดำเนินการ (Quick, Complete หรือ
Custom) จะแสดงขึ้นเชนกัน แถบความคืบหนาหลักจะแสดงเปอรเซ็นตที่ทำเสร็จของชุดการทดสอบปจจุบนั ขณะที่อยู
ระหวางการทดสอบ ปุม Cancel Testing จะแสดงข้ึนเพ่ือใหใชในกรณีที่คุณตองการยกเลิกการทดสอบ

หลังจากทดสอบเสร็จสิ้น ปุม Cancel Testing จะถูกแทนที่ดวยปุม Retest ปุม Retest จะทดสอบชุดการทดสอบลาสุดอีก
ครั้ง วิธีนี้ชวยใหคุณสามารถทำการทดสอบซ้ำโดยไมตองปอนขอมูลอีกครั้งในแท็บ Test

แท็บ Status ยังจะแสดง:

● อุปกรณที่ถูกทดสอบ

● สถานะของการทดสอบ (กำลังทดสอบ ผานหรือไมผาน) ของแตละอุปกรณที่ทำการทดสอบ

● ความคืบหนาโดยรวมของการทดสอบสำหรับทุกอุปกรณที่กำลังทำการทดสอบ

● ความคืบหนาของการทดสอบสำหรับแตละอุปกรณที่กำลังทำการทดสอบ

● เวลาทดสอบที่ใชสำหรับแตละอุปกรณที่กำลังทำการทดสอบ

แท็บ Log
แท็บ Log มีแท็บ Test Log และแท็บ Error Log อยูภายใน

Test Log จะแสดงการทดสอบทั้งหมดที่ดำเนินการไปแลว จำนวนคร้ังของการดำเนินการ จำนวนคร้ังที่การทดสอบลมเหลว
และเวลาที่ใชในการทดสอบแตละคร้ังจนเสร็จส้ิน ปุม Clear Test Log จะลบเน้ือหาทั้งหมดของ Test Log
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Error Log จะแสดงการทดสอบของอุปกรณที่ลมเหลวระหวางการทดสอบวินิจฉัย และรวมถึงขอมูลคอลัมนตอไปน้ี

● สวน Device จะแสดงอุปกรณที่ทำการทดสอบแลว

● สวน Test จะแสดงประเภทของการทดสอบที่ใช

● สวน Description จะแสดงรายละเอียดขอผิดพลาดที่พบในการทดสอบวินิจฉัย

● Recommended Repair คือการแกไขที่แนะนำ ซ่ึงควรดำเนินการเพื่อแกไขปญหาฮารดแวรลมเหลว

● Failed Count คือจำนวนครั้งที่อุปกรณไมผานการทดสอบ

● Error Code แจงรหัสตัวเลขของความลมเหลว รหัสขอผิดพลาดมีระบุไวในแท็บ Help

ปุม Clear Error Log จะลบเนื้อหาทั้งหมดของ Error Log

แท็บ Help
แท็บ Help จะมีทั้งแท็บ HP Insight Diagnostics แท็บ Error Codes และแท็บ Test Components

แท็บ HP Insight Diagnostics ประกอบดวยหัวขอความชวยเหลือ รวมทั้งคุณสมบัติในการคนหาและดัชนี

แท็บ Error Codes จะใหขอมูลรายละเอียดของรหัสขอผิดพลาดที่แสดงเปนตัวเลขแตละรหัสที่อาจปรากฏในแท็บ Error
Log บนแท็บ Log รหัสแตละตัวมี Message แสดงขอผิดพลาดที่ตรงกันและ Recommended Repair หรือส่ิงที่ควรทำ
ที่อาจชวยแกปญหา สำหรับการคนหาคำอธิบายรหัสขอผิดพลาดอยางรวดเร็ว ใหปอนรหัสในกลองที่ดานบนของแท็บ และ
คลิกปุม Find Error Codes

แท็บ Test Components จะแสดงขอมูลระดับลางของการทดสอบที่กำลังทำอยู

การบันทึกและการพิมพขอมูลใน HP Insight Diagnostics
คุณสามารถบันทึกขอมูลท่ีแสดงในแท็บ HP Insight Diagnostics Survey และแท็บ Log ลงในแผนดิสเก็ตตหรือ
อุปกรณ USB 2.0 HP Drive Key (64MB หรือสูงกวา) คุณไมสามารถบันทึกลงในฮารดไดรฟ ระบบจะสรางไฟล html
โดยอัตโนมัติ ซ่ึงจะมีลักษณะเหมือนกับขอมูลที่แสดงที่หนาจอ

1. ใสแผนดิสเก็ตตต หรืออุปกรณ USB 2.0 HP Drive Key (ความจุตองมากกวา 64MB) ไมสนับสนุนอุปกรณ USB
1.0 Drive Keys

2. คลิก Save ที่มุมขวาลางของหนาจอ

3. เลือก Save to the floppy หรือ Save to USB key

4. ปอนช่ือไฟลในกลอง File Name และคลิกปุม Save ไฟล html จะถูกบันทึกในแผนดิสเก็ตตท่ีใสไวหรืออุปกรณ USB
HP Drive Key

หมายเหตุ หามดึงแผนดิสเก็ตตหรือ USB คียออกจนกวาคุณจะเห็นขอความที่แจงวา ไฟล html ถูกเขียนลง
ไปที่ส่ือแลว

5. พิมพขอมูลจากอุปกรณส่ือจัดเก็บที่ใชบันทึกไฟลน้ัน

หมายเหตุ หากตองการออกจากยูทิลิต ีHP Insight Diagnostics คลิกที่ปุม Exit Diagnostics ตรงมุมซายลาง
ของหนาจอ กอนดึง แผนซีดี Documentation and Diagnostics ออกจากไดรฟออปติคัล
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การดาวนโหลดเวอรชันลาสุดของยูทิลิตี HP Insight Diagnostics
1. ไปที่ http://www.hp.com

2. คลิกที่ลิงค Software & Driver Downloads

3. ปอนหมายเลขผลิตภัณฑ (ตัวอยางเชน dc5700) ลงในกลองขอความและกดปุม Enter

4. เลือกรุนคอมพิวเตอรของคุณ

5. เลือกระบบปฏิบัติการของคุณ

6. คลิกที่ลิงค Diagnostic

7. คลิกที่ HP Insight Diagnostics Offline Edition

8. เลือกภาษาและคลิก Download

หมายเหตุ การดาวนโหลดจะรวมคำแนะนำวิธีการสรางซีดีที่สามารถบูตไดไวดวย

การปองกันซอฟตแวร
ในการปองกันความเสียหายหรือการสูญหายของซอฟตแวร คุณควรเก็บรักษาสำเนาของไฟลระบบ แอปพลิเคชัน และไฟลที่
เกี่ยวของที่เก็บไวในฮารดไดรฟทั้งหมดไว โปรดดูเอกสารของระบบปฏิบัติการหรือยูทิลิตีสำรองขอมูล เพื่อดูคำแนะนำเกี่ยว
กับการสำรองไฟลขอมูล

การกูคืนซอฟตแวร
HP Backup and Recovery Manager เปนแอปพลิเคชันที่ใชไดงาย และมีประโยชน แอปพลิเคชันนี้ถูกโหลดมาไวบนแต
ละระบบไวแลวลวงหนา และอนุญาตใหคุณ:

● สรางจุดการกูคืนเพื่อสำรองขอมูลทั้งหมดแบบสะสม

● สำรองขอมูลที่อยูบนทัง้ฮารดไดรฟไวในแหลงจัดเก็บเดียว

● สำรองขอมูลแตละไฟล

คุณอาจกำหนดเวลาใหเครื่องทำการสำรองขอมูลใหโดยอัตโนมัต ิหรือเลือกทำการสำรองดวยตัวคุณเอง การกูคืนขอมูลอาจทำ
จาก Recovery Partition บนฮารดไดรฟหรือจากชุดแผนดิสกสำหรับการเรียกคืน ชุดแผนดิสกสำหรับการเรียกคืนรวมแผน
ซีดี Restore Plus! ระบบปฏิบัติการ Microsoft และแผนซีดีซอฟตแวรเพ่ิมเติม

หมายเหตุ HP ขอแนะนำใหคุณสรางชุดแผนดิสกสำหรับการเรียกคืนทันทีหลังจากใชคอมพิวเตอร และกำหนด
เวลาสำรองขอมูลแบบ Recovery Point โดยอัตโนมัติอยางสม่ำเสมอ

HP Backup and Recovery Manager มาพรอมกับวิธีการกูคืนขอมูลพ้ืนฐานสองวิธ ีอันไดแก วิธีแรกคือการกูคืนไฟล
และโฟลเดอร วิธีนี้ทำงานใน Windows วิธีที่สองคือการกูคืนจากเครื่องคอมพิวเตอรซึ่งตองทำควบคูกับการรีบูตเคร่ืองมาที่
Recovery Partition หรือรีบูตเครื่องจากชุดแผนดิสกสำหรับการเรียกคืน ในการรีบูตเคร่ืองใหมาที ่Recovery
Partition ใหกด F11 ขณะเปดเคร่ืองเมื่อคุณเห็นขอความ “Press F11 for Emergency Recovery”

หมายเหตุ สำหรับขอมูลเพ่ิมเติมเกี่ยวกับการใช HP Backup and Recovery Manager โปรดดูที่ คูมือผูใชตัว
จัดการการสำรองและการเรียกขอมูลคืน ดวยการเลือก Start > HP Backup and Recovery > HP Backup
and Recovery Manager Manual
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2 การแกไขปญหาโดยไมผานโปรแกรมวินิจฉัย

บทนี้จะใหขอมูลเกี่ยวกับการระบุและการแกไขปญหาที่ไมรายแรง เชน ปญหาที่เกี่ยวกับดิสเก็ตตไดรฟ ฮารดไดรฟ
ไดรฟออปติคัล กราฟก หนวยความจำ และซอฟตแวร หากคุณพบปญหาเก่ียวกับเครื่องคอมพิวเตอร โปรดอางอิงตารางในบท
นี้เพ่ือดูรายละเอียดเกี่ยวกับสาเหตุที่เปนไปไดและวิธีแกไขที่แนะนำ

หมายเหตุ สำหรับขอมูลเก่ียวกับขอความแสดงขอผิดพลาดที่อาจปรากฏบนหนาจอระหวางการทดสอบเริ่มทำงาน
ดวยตนเอง (Power On Self Test \endash POST) โปรดดูที่ภาคผนวก A ขอความแสดงขอผิดพลาดของ POST

ความสะดวกและความปลอดภัย
คำเตือน! การใชคอมพิวเตอรอยางผิดวิธีหรือการติดตั้งในสภาพแวดลอมการทำงานที่ไมปลอดภัยและไมเหมาะสม
อาจกอใหเกิดปญหาการใชงานไมสะดวกหรือเปนอันตรายรายแรงได โปรดดูหัวขอ คูมือเพื่อความปลอดภัยและ
ความสะดวกสบาย ใน แผนซีดี Documentation and Diagnostics และเลือกดูจากเว็บไซตที่
http://www.hp.com/ergo สำหรับขอมูลเพ่ิมเติมเกี่ยวกับการเลือกพ้ืนที่ทำงานและการสรางสภาพแวดลอมในการ
ทำงานที่ปลอดภัยและสะดวกสบาย อุปกรณนี้ผานการทดสอบแลวและพบวาตรงตามขอจำกัดสำหรับอุปกรณดิจิตอล
คลาส B ตามขอ 15 ของกฎ FCC สำหรับขอมูลเพิ่มเติม โปรดดูที่ ขอมูลเก่ียวกับความปลอดภัยและขอบังคับตางๆ
ใน แผนซีดี Documentation and Diagnostics

กอนท่ีจะติดตอฝายสนับสนุนดานเทคนิค
หากคุณพบปญหาเกี่ยวกับเครื่องคอมพิวเตอร ใหลองใชวิธีแกไขตอไปนี้เพื่อแยกปญหาที่แกไขไมได กอนที่จะติดตอขอรับ
บริการสนับสนุนดานเทคนิค

● การรันยูทิลิตีการวินิจฉัยปญหา โปรดดูที่บทที่ 1 คุณสมบัติการวินิจฉัยระบบคอมพิวเตอร สำหรับขอมูลเพิ่มเติม

● รันการทดสอบระบบปองกันไดรฟ (Drive Protection System - DPS) ในโปรแกรมการตั้งคาคอมพิวเตอร โปรดดู
รายละเอียดเพิ่มเติมใน คูมือยูทิลิตีการตั้งคาคอมพิวเตอร (F10) ใน แผนซีดี Documentation and Diagnostics

● ตรวจสอบไฟสถานะเปดเครื่องที่ดานหนาของเครื่องคอมพิวเตอร เพื่อดูวาไฟกะพริบเปนสีแดงหรือไม ไฟที่กะพริบคือ
รหัสขอผิดพลาดที่จะชวยคุณวินิจฉัยปญหาที่เกิดขึ้น โปรดดูขอมูลเพิ่มเติมในภาคผนวก A ขอความแสดงขอผิดพลาด
ของ POST

● หากหนาจอวางเปลาปรากฏ ใหเสียบปล๊ักของจอภาพลงในพอรตวิดีโอพอรตอื่นบนคอมพิวเตอรหากมีพอรตนั้นอยู หรือ
เปลี่ยนไปใชจอภาพที่คุณแนใจวาทำงานเปนปกติ

● หากคุณทำงานบนระบบเน็ตเวิรก ใหเสียบคอมพิวเตอรอีกเคร่ืองหนึ่งพรอมสายเคเบิลสายอื่นลงในระบบการเช่ือมตอ
ของเน็ตเวิรก ปญหาอาจอยูที่ปล๊ักหรือสายเคเบิลของระบบเน็ตเวิรก

● หากคุณเพิ่งเพ่ิมฮารดแวรใหมลงไป ใหถอดฮารดแวรน้ันออก และดูวาคอมพิวเตอรทำงานไดอยางเหมาะสมหรือไม

● หากคุณเพิ่งติดตั้งซอฟตแวรใหมลงไป ใหลบซอฟตแวรน้ันออกจากเครื่อง และดูวาคอมพิวเตอรทำงานไดอยางเหมาะ
สมหรือไม
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● บูตคอมพิวเตอรมาที่ Safe Mode เพื่อดูวาคอมพิวเตอรจะบูตข้ึนมาหรือไมหากไมไดโหลดไดรเวอรทั้งหมด เม่ือบูต
ระบบปฏิบัติการ ใหใช “Last Known Configuration”

● โปรดติดตั้งฝายสนับสนุนทางเทคนิคทางออนไลนไดที่ http://www.hp.com/support

● โปรดดูหัวขอ คำแนะนำ ในคูมือนี้

HP Instant Support Professional Edition ไดจัดเตรียมการวินิจฉัยเพื่อการแกปญหาไวใหกับคุณเพื่อชวยคุณแกปญหา
แบบออนไลน หากคุณตองการติดตอบริการสนับสนุนของ HP ใหใชคุณสมบัติการสนทนาออนไลนของ HP Instant
Support Professional Edition โดยเขาใชงาน HP Instant Support Professional Edition ไดที่:
http://www.hp.com/go/ispe

เชื่อมตอเขาสู Business Support Center (BSC) ที่ http://www.hp.com/go/bizsupport เพ่ือดูขอมูลลาสุดเก่ียวกับ
การสนับสนุนแบบออนไลน ซอฟตแวรและไดรเวอร การแจงเตือนลวงหนา และชุมชนผูใชและผูเชี่ยวชาญของ HP ทั่วโลก

หากคุณจำเปนตองโทรศัพทติดตอเพ่ือขอความชวยเหลือดานเทคนิค โปรดปฏิบัติตามขั้นตอนตอไปน้ีเพื่อใหคุณไดรับการ
บริการอยางเหมาะสม:

● อยูหนาคอมพิวเตอรในขณะที่โทรติดตอ

● จดซีเรียลนัมเบอรของคอมพิวเตอรและเลขที ่ID ของผลิตภัณฑ และซีเรียลนัมเบอรของจอภาพ กอนที่จะโทรศัพท

● เวลาที่ใชแกปญหารวมกับชางเทคนิค

● ถอดฮารดแวรที่เพ่ิงเพ่ิมลงในระบบออกไปกอน

● ลบซอฟตแวรที่เพิ่งติดต้ังออกไปกอน

● เรียกคืนระบบไปที ่Recovery Point ซึ่งสรางไวใน HP Backup and Recovery Manager หรือรันแผนซีดี
Restore Plus! สำหรับขอมูลเพ่ิมเติมเก่ียวกับการใช HP Backup and Recovery Manager โปรดดูที่ คูมือผูใช
ตัวจัดการการสำรองและการเรียกขอมูลคืน ดวยการเลือก Start > HP Backup and Recovery > HP Backup
and Recovery Manager Manual

ขอควรระวัง การรันซีดี Restore Plus! แผนซีดีจะลบขอมูลทั้งหมดที่อยูบนฮารดไดรฟ

หมายเหตุ สำหรับขอมูลเกี่ยวกับการขายและการเพิ่มการรับประกัน (Care Packs) โปรดติดตอตัวแทนจำหนาย
หรือผูใหบริการที่ไดรับอนุญาตในพื้นที่ของคุณ

คำแนะนำ
หากคุณพบปญหาเกี่ยวกับคอมพิวเตอร จอภาพ หรือซอฟตแวร โปรดดูที่รายการคำแนะนำโดยทั่วไปตอไปนี้กอนดำเนินการ
ใดๆ ตอ:

● ตรวจสอบวาคอมพิวเตอรและจอภาพตอเขากับเตาเสียบที่มีกระแสไฟฟา

● ตรวจสอบสวิตชเลือกระดับแรงดันไฟฟาวาอยูในตำแหนงของระดับแรงดันไฟฟาที่ถูกตองสำหรับพ้ืนที่ที่คุณอาศัยอยู
(115V หรือ 230V)

● ตรวจสอบวา ไดเปดคอมพิวเตอรแลวและไฟเพาเวอรสีเขียวติดสวาง

● ตรวจสอบวา ไดเปดจอภาพแลวและไฟจอภาพสีเขียวติดสวาง

● ตรวจสอบไฟสถานะเปดเคร่ืองที่ดานหนาของเครื่องคอมพิวเตอร เพื่อดูวาไฟกะพริบเปนสีแดงหรือไม ไฟที่กะพริบคือ
รหัสขอผิดพลาดที่จะชวยคุณวินิจฉัยปญหาท่ีเกิดข้ึน โปรดดูขอมูลเพิ่มเติมในภาคผนวก A ขอความแสดงขอผิดพลาด
ของ POST

● ปรับปุมควบคุมความสวางและความคมชัดของจอภาพหากจอภาพเปนสีจาง
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● กดปุมใดปุมหนึ่งคางไว หากระบบสงเสียงบี๊ป แสดงวาแปนพิมพทำงานตามปกติ

● ตรวจสอบวาจุดเช่ือมตอสายเคเบิลทั้งหมดไมหลุดหลวมหรือเชื่อมตอไมถูกตอง

● เรียกใชคอมพิวเตอรไดดวยการกดปุมใดก็ไดบนแปนพิมพหรือกดปุมเพาเวอร หากเคร่ืองคอมพิวเตอรยังคงอยูใน
โหมดพักการใชงาน ใหปดเคร่ืองโดยใชวิธีกดปุมเพาเวอรคางไวอยางนอย 4 วินาที จากนั้นใหกดปุมเพาเวอรอีกคร้ัง
เพ่ือรีสตารทคอมพิวเตอร หากระบบคางไมยอมปด ใหถอดปลั๊ก รอประมาณ 1-2 วินาที และเสียบปล๊ักใหมอีกคร้ัง
คอมพิวเตอรจะรีสตารท หากวามีการกำหนดใหเคร่ืองเริ่มตนการทำงานโดยอัตโนมัติไวในโปรแกรมการตั้งคา
คอมพิวเตอรหลังจากไฟฟาดับ หากคอมพิวเตอรไมเริ่มการทำงานใหมอีกคร้ัง ใหกดปุมเพาเวอรเพื่อเริ่มการทำงานของ
คอมพิวเตอร

● ต้ังคาเคร่ืองคอมพิวเตอรใหมหลังจากติดตั้งการดเอ็กซแพนชนัหรืออุปกรณเสริมที่ไมใชแบบ Plug and Play โปรดดู
คำแนะนำใน การแกไขปญหาในการติดตั้งฮารดแวร

● ตรวจสอบใหแนใจวา ไดติดต้ังไดรเวอรอุปกรณทั้งหมดที่จำเปนแลว ตัวอยางเชน หากคุณกำลังใชเคร่ืองพิมพ คุณตอง
ใชไดรเวอรสำหรับเครื่องพิมพในรุนนั้น

● ยายสื่อที่ใชบูตระบบทั้งหมด (แผนดิสก ซีดีหรืออุปกรณ USB) ออกจากระบบกอนเปดเคร่ือง

● หากคุณไดติดตั้งระบบปฏิบัติการอื่นที่ไมใชระบบที่ติดตั้งมาจากโรงงาน โปรดตรวจสอบวาระบบนั้นสามารถทำงานได
ในเคร่ืองคอมพิวเตอรของคุณ

● หากระบบมีอุปกรณแหลงสัญญาณภาพหลายตัว (อะแดปเตอรภายใน, PCI หรือ PCI-Express) ติดต้ังอยู (วิดีโอแบบ
ติดตั้งภายในมีในบางรุนเทาน้ัน) และมีจอภาพเพียงเคร่ืองเดียว จอภาพดังกลาวจะตองตอเขากับชองเสียบจอภาพบน
แหลงสัญญาณภาพที่คุณเลือกเปนอะแดปเตอร VGA หลัก ในระหวางการบูตเครื่อง ชองเสียบจอภาพอื่นจะถูกปด และ
หากตอจอภาพเขากับพอรตเหลานี ้จอภาพจะไมทำงาน คุณสามารถเลือกแหลงสัญญาณภาพที่เปนคาดีฟอลตสำหรับ
แหลงสัญญาณ VGA ไดในโปรแกรมการตั้งคาคอมพิวเตอร

ขอควรระวัง เมื่อตอสายไฟกับเคร่ืองคอมพิวเตอร แหลงจายไฟจะมีแรงดันไฟฟาสำหรับเมนบอรดอยูตลอดเวลา
คุณตองถอดสายไฟออกจากเตาเสียบกอนที่จะเปดฝาเคร่ืองคอมพิวเตอรเพื่อปองกันความเสียหายกับเมนบอรดหรือ
สวนประกอบภายในเครื่อง
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การแกปญหาทั่วไป
คุณสามารถแกไขปญหาทั่วไปตามที่อธิบายไวในหัวขอนี้ไดอยางงายดาย หากปญหายังคงอยูและคุณไมสามารถแกไขไดดวย
ตนเอง หรือหากคุณไมตองการดำเนินการดวยตนเอง โปรดติดตอผูขายหรือตัวแทนจำหนายท่ีไดรับอนุญาต

คำเตือน! เม่ือตอสายไฟกับเครื่องคอมพิวเตอร แหลงจายไฟจะมีแรงดันไฟฟาสำหรับเมนบอรดอยูตลอดเวลา เพ่ือ
ลดความเสี่ยงที่จะไดรับบาดเจ็บจากไฟฟาช็อต และ/หรือพ้ืนผิวที่รอน คุณควรตรวจดูใหแนใจวา ไดถอดปล๊ักไฟแลว
และปลอยใหสวนประกอบภายในของระบบเย็นกอนจะสัมผัส

ใหมองไปที่ไฟ LED ในเมนบอรด ในกรณีที่ไฟ LED สวาง แสดงวาเมนบอรดยังคงมีกระแสไฟอยู ปดเครื่อง
คอมพิวเตอรและถอดปลั๊กออกกอนจะดำเนินการตอ

ตาราง 2-1  การแกปญหาทั่วไป

คอมพิวเตอรคางและไมยอมปดลงเมื่อกดปุมเพาเวอร

สาเหตุ วิธีแกไข

ระบบควบคุมสวิตชเพาเวอรดวยซอฟตแวรไมทำงาน 1. กดปุมเพาเวอรคางไวเปนเวลาอยางนอย 4 วินาที จนกระท่ังเคร่ือง
คอมพิวเตอรปดลง

2. ถอดสายไฟออกจากเตารับไฟฟา

คอมพิวเตอรไมสนองตอบกับแปนพิมพหรือเมาส USB

สาเหตุ วิธีแกไข

คอมพิวเตอรอยูในโหมด สแตนดบาย ในการออกจากโหมด สแตนดบาย ใหกดปุมเพาเวอร

ขอควรระวัง เมื่อพยายามจะทำงานตอจากโหมด สแตนดบาย
อยากดปุมเพาเวอรนานเกินสี่วินาที มิฉะนั้น คอมพิวเตอรจะปด
ลง และคุณจะสูญเสียขอมูลท่ียังไมไดจัดเก็บ

ระบบคาง รีสตารทคอมพิวเตอร

เคร่ืองคอมพิวเตอรแสดงวันท่ีและเวลาไมถูกตอง

สาเหตุ วิธีแกไข

คุณอาจตองเปล่ียนแบตเตอรี่ของนาฬิกาภายในระบบ (RTC - real-time
clock)

หมายเหตุ การเสียบปล๊ักคอมพิวเตอรเขากับเตารบัไฟฟาจะ
ชวยยืดอายกุารใชงานของแบตเตอรี่ RTC

ข้ันแรก ใหรีเซ็ตวันที่และเวลาที ่Control Panel (หรืออาจใชยูทิลิตีการตั้ง
คาคอมพิวเตอรเพ่ืออัพเดตวันท่ีและเวลาของ RTC) หากปญหายังคงอยู ให
เปลี่ยนแบตเตอรี่ RTC โปรดดู คูมืออางอิงฮารดแวร ใน แผนซีดี
Documentation and Diagnostics เพื่อดูคำแนะนำเก่ียวกับการติดตั้ง
แบตเตอรี่ใหม หรือติดตอตัวแทนจำหนายหรือผูขายที่ไดรับอนุญาตเพื่อขอ
คำแนะนำในการเปลี่ยนแบตเตอรี ่RTC

เคอรเซอรไมเคล่ือนไหวเมื่อใชปุม ลูกศร บนแปนพิมพ

สาเหตุ วิธีแกไข

ปุม Num Lock อาจอยูในสถานะใชงาน กดปุม Num Lock ไฟสถานะ Num Lock ไมควรจะเปดอยูหากคุณตอง
การใชปุม ลูกศร สามารถเปด (หรือปดการใชงาน) ปุม Num Lock ไดใน
ยูทิลิตีการตั้งคาคอมพวิเตอร
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ไมมีเสียงหรือระดับเสียงเบามาก

สาเหตุ วิธีแกไข

ระดับเสียงของเครื่องอาจจะถูกต้ังใหเบาหรอืปดเสียง 1. ตรวจสอบการตัง้คา F10 BIOS เพ่ือใหแนใจไดวาลำโพงภายใน
เครื่องไมไดปดเสียงไว (การตั้งคาน้ีจะไมมีผลกับลำโพงภายนอก)

2. ตรวจสอบใหแนใจวา ลำโพงภายนอกไดเชื่อมตอไวถูกตองหรือไม
และเปดเคร่ืองและตั้งคาระดับเสียงของลำโพงไดอยางถูกตอง

3. ใชตัวควบคุมเสียงท่ีมีอยูในระบบปฏิบัติการเพ่ือใหแนใจวาลำโพงไม
ไดถูกปดเสียง หรือเพ่ิมระดับเสียง

อาจตอสายอุปกรณเสียงเขากับแจ็คท่ีอยูท่ีดานหลังของคอมพิวเตอรผิดอนั
หรือสายแจ็คถูกปรับใหทำงานในฟงกชันท่ีตางออกไป

ดูใหแนใจวา ไดตออุปกรณเขากับแจ็คท่ีถกูตองท่ีดานหลังของคอมพิวเตอร
ถาใชแจ็คที่ถูกตองแลวและยังคงมีปญหาอยู แสดงวา แจ็คอาจถูกปรับเพื่อ
ใหทำงานในฟงกชันที่ตางจากฟงกชันเร่ิมตน เปดแผงควบคุม Realtek
โดยการคลิกท่ีไอคอน Realtek HD Audio Manager ในถาดงานหรือ
รายการ Realtek ในแผงควบคุมของระบบปฏิบัติการและต้ังคา
แจ็คใหทำงานในฟงกชันท่ีตองการ

มีการทำงานอยางไมเต็มประสิทธิภาพ

สาเหตุ วิธีแกไข

โปรเซสเซอรมีอุณหภูมิสูง 1. ดูใหแนใจวาชองระบายอากาศไมถูกปดก้ัน เวนพ้ืนท่ีวางประมาณ
10.2 ซม. (4 นิ้ว) ทุกดานท่ีมีทางระบายอากาศของเครื่อง
คอมพิวเตอรและดานบนของจอภาพเพื่อใหอากาศถายเทไดสะดวก

2. ตรวจดวูาพัดลมถูกเชื่อมตอและทำงานอยางถูกตอง (พัดลมบางตัวทำ
งานเมื่อจำเปนเทานั้น)

3. ตรวจสอบวาตัวระบายความรอนของโปรเซสเซอรถูกติดตั้งอยางถูก
ตอง

ฮารดไดรฟเต็ม ถายโอนขอมูลจากฮารดไดรฟ เพ่ือเพิ่มพ้ืนท่ีวางบนฮารดไดรฟ

หนวยความจำเหลือนอย เพ่ิมหนวยความจำ

ขอมูลบนฮารดไดรฟกระจัดกระจาย ดีแฟรกฮารดไดรฟ

โปรแกรมที่เรียกใชงานกอนหนาน้ีไมปลอยหนวยความจำที่สำรองไวกลับ
คืนสูระบบ

เริ่มการทำงานของคอมพิวเตอรใหม

มีไวรัสบนฮารดไดรฟ รันโปรแกรมปองกันไวรัส

รันแอปพลิเคชันมากเกินไป 1. ปดแอปพลิเคชันท่ีไมจำเปนเพ่ือเพ่ิมหนวยความจำ บางโปรแกรมรัน
ในพ้ืนหลังและสามารถปดโดยการคลิกขวาท่ีไอคอนที่เก่ียวของใน
ถาดงาน ในการปองกันไมใหโปรแกรมเหลาน้ีเปดขึ้นมาตัง้แตการ
เร่ิมตนระบบ ใหไปท่ี Start > Run และพิมพ msconfig ท่ีแท็บ
Startup ของ System Configuration Utility ใหเอาเคร่ืองหมาย
ถูกออกจากโปรแกรมที่คุณไมตองการใหเปดโดยอตัโนมัติ

ขอควรระวัง หามปองกันการเปดโปรแกรมที่จำเปนตอ
ระบบปฏิบัติการเพื่อการเริ่มตนระบบท่ีเหมาะสม

2. เพ่ิมหนวยความจำ

ตาราง 2-1  การแกปญหาทั่วไป (ตอ)
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มีการทำงานอยางไมเต็มประสิทธิภาพ

สาเหตุ วิธีแกไข

แอปพลิเคช่ันซอฟตแวรบางประเภท โดยเฉพาะเกมส จะใชระบบยอยการ
แสดงผลกราฟกในระดับสูง

1. ใหลดความละเอียดการแสดงผลสำหรับแอปพลิเคชั่นปจจบุันหรือ
ศึกษาจากเอกสารประกอบที่จัดสงมาพรอมกับแอปพลิ
เคชันน้ันเพื่อดูคำแนะนำเกีย่วกับวิธีการปรับปรุงประสิทธิภาพดวย
การปรบัคาพารามิเตอรในแอปพลิเคช่ัน

2. เพิ่มหนวยความจำ

3. อัพเกรดโซลูชันดานกราฟก

ไมทราบสาเหตุ เริ่มการทำงานของคอมพิวเตอรใหม

เคร่ืองปดเองโดยอัตโนมัติและไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 2 คร้ังทุกๆ วินาที จากน้ันเวน 2 วินาที และมีสัญญาณเสียง 2 คร้ัง (เสียงเตือนจะหยุด
หลังจากดังติดตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

ระบบปองกันความรอนของโปรเซสเซอรถูกเปดใชงาน:

พัดลมอาจถูกปดก้ันหรือไมทำงาน

หรือ

ตัวระบายความรอน/พัดลมไมไดเช่ือมตอกับโปรเซสเซอรอยางถูกตอง

1. ตรวจสอบวาชองระบายอากาศไมไดถูกปดก้ันและพัดลมระบายความ
รอนทำงาน

2. เปดฝาครอบ กดปุมเพาเวอร แลวดูวาพัดลมที่โปรเซสเซอรหมุนหรือ
ไม หากพัดลมท่ีโปรเซสเซอรไมหมุน ใหตรวจดูวา ไดเสียบสายเคเบิล
ของพัดลมเขากับเฮดเดอรบนเมนบอรดเรียบรอยแลวใชหรือไม

3. หากตอพัดลมแลวแตพัดลมไมหมุน ใหเปล่ียนช้ินสวนตัวระบายความ
รอน/พัดลม

4. ติดตอผูใหบริการหรือตัวแทนจำหนายท่ีไดรับอนุญาต

ไมสามารถเปดเครื่องคอมพิวเตอร และไฟแสดงสถานะที่แผงดานหนาของคอมพิวเตอรไมกะพริบ

สาเหตุ วิธีแกไข

ไมสามารถเริ่มตนการทำงานของระบบ กดปุมเพาเวอรคางไวไมถึง 4 วินาที หากไฟสถานะฮารดไดรฟเปลี่ยนเปนสี
เขียว ใหปฏิบัติดังนี:้

1. ตรวจสอบสวิตชเลือกระดับแรงดันไฟฟาที่ดานหลังของแหลงจายไฟ
บางรุนวาอยูในตำแหนงของระดับแรงดันไฟฟาท่ีถูกตอง การต้ังคา
แรงดันไฟฟาท่ีเหมาะสมขึ้นอยูกับประเทศ/พ้ืนท่ีท่ีคุณอาศัยอยู

2. ถอดการดเอ็กซแพนชันทีละชิ้นจนกวาไฟ 5V_aux บนเมนบอรดจะ
สวาง

3. เปลี่ยนเมนบอรด

หรือ

กดปุมเพาเวอรคางไวไมถึง 4 วินาที หากไฟสถานะฮารดไดรฟไมเปลี่ยน
เปนสีเขียว ใหปฏิบัติดังนี:้

1. ตรวจดูวาอุปกรณเสียบปล๊ักเขากับเตารับไฟฟาอยางถูกตอง

2. เปดฝาครอบ แลวตรวจดูวาตัวควบคุมปุมเพาเวอรเช่ือม ตอเขากับ
เมนบอรดอยางถูกตอง

3. ตรวจดูวาสายแหลงจายไฟท้ัง 2 สายเชื่อมตอเขากับเมนบอรดอยาง
ถูกตอง

ตาราง 2-1  การแกปญหาทั่วไป (ตอ)
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ไมสามารถเปดเครื่องคอมพิวเตอร และไฟแสดงสถานะที่แผงดานหนาของคอมพิวเตอรไมกะพริบ

สาเหตุ วิธีแกไข

4. ตรวจดูวาไฟ 5V_aux บนเมนบอรดสวางหรือไม ถาไฟสวาง ให
เปล่ียนตัวควบคุมปุมเพาเวอร

5. ถาไฟ 5V_aux บนเมนบอรดดับ ใหเปล่ียนแหลงจายไฟ

6. เปล่ียนเมนบอรด

ตาราง 2-1  การแกปญหาทั่วไป (ตอ)
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การแกไขปญหาเกี่ยวกับไฟ
ตารางตอไปนี้แสดงสาเหตุและการแกไขปญหาเกี่ยวกับไฟท่ีพบบอย

ตาราง 2-2  การแกไขปญหาเกี่ยวกับไฟ

แหลงจายไฟไมทำงานในบางครั้ง

สาเหตุ วิธีแกไข

สวิตชเลือกระดับแรงดันไฟฟาที่ดานหลังของโครงเครื่อง (บางรุน) ไมอยูใน
ตำแหนงของระดับแรงดันไฟฟาท่ีถูกตอง (115V หรือ 230V)

เลือกระดับแรงดันไฟฟากระแสสลับท่ีถกูตองโดยใชสวิตชเลือก

แหลงจายไฟไมทำงานเน่ืองจากมีขอขัดของภายใน ติดตอผูใหบริการท่ีไดรับอนุญาต เพื่อเปล่ียนแหลงจายไฟ

เคร่ืองปดเองโดยอัตโนมัติและไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 2 คร้ังทุกๆ วินาที จากน้ันเวน 2 วินาที และมีสัญญาณเสียง 2 คร้ัง (เสียงเตือนจะหยุด
หลังจากดังติดตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

ระบบปองกันความรอนของโปรเซสเซอรถูกเปดใชงาน:

พัดลมอาจถูกปดก้ันหรือไมทำงาน

หรือ

ตัวระบายความรอน/พัดลมไมไดเช่ือมตอกับโปรเซสเซอรอยางถูกตอง

1. ตรวจสอบวาชองระบายอากาศไมไดถูกปดก้ันและพัดลมระบายความ
รอนทำงาน

2. เปดฝาครอบ กดปุมเพาเวอร แลวดูวาพัดลมที่โปรเซสเซอรหมุนหรือ
ไม หากพัดลมท่ีโปรเซสเซอรไมหมุน ใหตรวจดูวา ไดเสียบสายเคเบิล
ของพัดลมเขากับเฮดเดอรบนเมนบอรดเรียบรอยแลวใชหรือไม

3. หากตอพัดลมแลวแตพัดลมไมหมุน ใหเปล่ียนช้ินสวนตัวระบายความ
รอน/พัดลม

4. ติดตอผูใหบริการหรือตัวแทนจำหนายท่ีไดรับอนุญาต

ไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 4 ครั้งทุกๆ วินาที จากน้ันเวน 2 วินาที และคอมพิวเตอรสงสัญญาณเสียง 4 คร้ัง (เสียงเตือนจะหยุดหลังจากดังติด
ตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

แหลงจายไฟไมทำงาน (แหลงจายไฟโอเวอรโหลด) 1. ตรวจสอบสวิตชเลือกระดับแรงดันไฟฟาที่ดานหลังของแหลงจายไฟ
(ในคอมพิวเตอรบางรุน) วาอยูในตำแหนงของระดับแรงดันไฟฟาท่ี
ถูกตอง การตั้งคาแรงดันไฟฟาที่เหมาะสมข้ึนอยูกับประเทศ/พ้ืนที่ท่ี
คุณอาศัยอยู

2. เปดฝาครอบ แลวตรวจดูวาสายเคเบิลของแหลงจายไฟแบบ 4 หรือ 6
สาย เชื่อมตอเขากับชองเสียบบนเมนบอรดแลว

3. ตรวจสอบวาอุปกรณเปนสาเหตุใหเกิดปญหาน้ีหรือไม โดยถอด
อุปกรณท้ังหมดท่ีเช่ือมตออยู (เชน ฮารดไดรฟ ดิสเก็ตตไดรฟ
หรือไดรฟออปติคัล และการดเอ็กซแพนชัน) เปดเครื่องคอมพิวเตอร
หากคอมพิวเตอรเขาสู POST ใหปดเคร่ือง แลวตออุปกรณกลับคืน
ครั้งละชิ้น และทำตามขั้นตอนดังกลาวซ้ำอีกคร้ังจนกวาเครื่องจะไม
ทำงาน เปลี่ยนอุปกรณท่ีเปนสาเหตุใหเคร่ืองไมทำงาน ตออุปกรณ
กลับคืนคร้ังละช้ิน เพ่ือใหแนใจวาอุปกรณทั้งหมดทำงานเปนปกติ

4. เปลี่ยนแหลงจายไฟ

5. เปลี่ยนเมนบอรด
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การแกไขปญหาเกี่ยวกับดิสเก็ตต
ตารางตอไปนี้แสดงสาเหตุและการแกไขปญหาเกี่ยวกับดิสเก็ตตที่พบบอย

หมายเหตุ คุณอาจตองต้ังคาคอมพิวเตอรใหมเมื่อคุณเพ่ิมหรือถอดฮารดแวร เชน ดิสเก็ตตไดรฟเพ่ิมเติม โปรดดูคำ
แนะนำใน การแกไขปญหาในการติดตั้งฮารดแวร

ตาราง 2-3  การแกไขปญหาเกี่ยวกับดิสเก็ตต

ไฟของดิสเก็ตตไดรฟติดตลอดเวลา

สาเหตุ วิธีแกไข

ดิสเก็ตตเกิดความเสียหาย ใน Microsoft Windows XP ใหคลิกขวาท่ี Start, click Explore แลว
เลือกไดรฟ เลือก File > Properties > Tools ใต Error-checking
คลิก Check Now

ใสแผนดิสเก็ตตไมถูกตอง ดึงแผนดิสเก็ตตออกและใสใหมอีกครั้ง

ตอสายเคเบิลของไดรฟไมถูกตอง ตอสายเคเบิลของไดรฟใหม ตรวจสอบใหแนใจวาพินทัง้สี่บนสายไฟตอเขา
กับดิสเก็ตตไดรฟอยางเหมาะสม

ไมพบไดรฟ

สาเหตุ วิธีแกไข

สายเคเบิลหลวม ตอสายเคเบิลขอมูลและสายไฟของดิสเก็ตตไดรฟอีกครั้ง

ไมไดติดต้ังไดรฟท่ีถอดเขาออกไดอยางถูกตอง ติดต้ังไดรฟใหมอีกคร้ัง

ดิสเก็ตตไดรฟไมสามารถเขียนลงแผนดิสเก็ตต

สาเหตุ วิธีแกไข

ไมไดฟอรแมตแผนดิสเก็ตต ฟอรแมตแผนดิสเก็ตต

1. เลือกไดรฟ (A) ใน Windows Explorer

2. คลิกขวาท่ีตัวอักษรของไดรฟ และเลือก Format

3. เลือกตัวเลือกท่ีตองการ และคลิก Start เพื่อเร่ิมฟอรแมตดิสเก็ตต

ดิสเก็ตตมีการปองกันการเขียน ใชดิสเก็ตตแผนอื่น หรือยกเลิกการปองกันการเขียน

มีการเขียนผิดไดรฟ ตรวจสอบช่ือไดรฟในขอความระบุตำแหนง

พ้ืนท่ีวางในดิสเก็ตตไมเพียงพอ 1. ใชแผนดิสเก็ตตอื่น

2. ลบไฟลท่ีไมตองการออกจากดิสเก็ตต

การเขียนดิสเก็ตตรุนเกาถูกยกเลิกการใชงานในยูทิลิตีการตั้งคา
คอมพิวเตอร

เขาสูยูทิลิตีการต้ังคาคอมพิวเตอร และเปดใช Legacy Diskette Write
ใน Storage > Storage Options

ดิสเก็ตตเกิดความเสียหาย เปลี่ยนดิสเก็ตต
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ไมสามารถฟอรแมตดิสเก็ตต

สาเหตุ วิธีแกไข

การรายงานสื่อเก็บขอมูลไมถูกตอง เมื่อฟอรแมตดิสกใน MS-DOS คุณอาจตองระบุความจุของแผน เชน ใน
การฟอรแมตดิสเก็ตตขนาด 1.44 เมกะไบต ใหพิมพคำสั่งตอไปนี้ใน พร
อมตของ MS-DOS:

FORMAT A: /F:1440

ดิสกอาจมีการปองกันการเขียน เปดตัวล็อคบนดิสเก็ตต

การเขียนดิสเก็ตตรุนเกาถูกยกเลิกการใชงานในยูทิลิตีการตั้งคา
คอมพิวเตอร

เขาสูยูทิลิตีการต้ังคาคอมพิวเตอร และเปดใช Legacy Diskette Write
ใน Storage > Storage Options

เกิดขอผิดพลาดในการใชงานดิสก

สาเหตุ วิธีแกไข

โครงสรางไดเรคทอรี่ไมถกูตอง หรือไฟลมีปญหา ใน Windows XP คลิกขวาท่ี Start คลิก Explore และเลือกไดรฟ
เลือก File > Properties > Tools ใต Error-checking คลิก Check
Now

ดิสเก็ตตไดรฟไมสามารถอานแผนดิสเก็ตต

สาเหตุ วิธีแกไข

คุณใชดิสเก็ตตผิดประเภทสำหรับไดรฟ ตรวจสอบประเภทของไดรฟท่ีคุณกำลังใช และใชดิสเก็ตตท่ีถูกตอง

คุณกำลังอานขอมูลผิดไดรฟ ตรวจสอบช่ือไดรฟในขอความระบุตำแหนง

ดิสเก็ตตเกิดความเสียหาย เปลี่ยนดิสเก็ตต

มีขอความ ”Invalid system disk” ปรากฏข้ึน

สาเหตุ วิธีแกไข

มีการใสดิสเก็ตตท่ีไมมีไฟลระบบทีจ่ำเปนตอการเปดคอมพิวเตอรลง
ในไดรฟ

เมื่อไดรฟหยุดทำงาน นำดิสเก็ตตออกและกด Spacebar คอมพิวเตอรจะ
เริ่มตนระบบตอไป

เกิดขอผิดพลาดในดิสเก็ตต รีสตารทคอมพิวเตอรของคณุ โดยกดปุมเพาเวอร

ไมสามารถบูตจากแผนดิสเก็ตต

สาเหตุ วิธีแกไข

แผนดิสเก็ตตเปนแบบท่ีบูตไมได เปลี่ยนเปนแผนดิสเก็ตตท่ีบูตได

มีการยกเลิกการบูตจากแผนดิสเก็ตตในยูทิลิตีการตั้งคาคอมพิวเตอร 1. รันยูทลิิตีการต้ังคาคอมพิวเตอร และเปดใชการบูตดวยดิสเก็ตตใน
Storage > Boot Order

2. รันยูทลิิตีการต้ังคาคอมพิวเตอร และเปดใชการบูตดวยดิสเก็ตตใน
Storage > Storage Options > Removable Media Boot

ตาราง 2-3  การแกไขปญหาเกี่ยวกับดิสเก็ตต (ตอ)
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ไมสามารถบูตจากแผนดิสเก็ตต

สาเหตุ วิธีแกไข

หมายเหตุ ควรปฏิบัติข้ันตอนท้ังสอง เพราะฟงกชัน
Removable Media Boot ในยูทิลิตีการตั้งคาคอมพิวเตอรจะ
แทนที่คำสั่งเปดใช Boot Order

Network Server Mode ถูกเปดใชงานในยูทิลิตีการตั้งคาคอมพิวเตอร รันยูทิลิตีการตั้งคาคอมพิวเตอร แลวยกเลิกการใชงานNetwork Server
Mode ใน Security > Password Options

ตาราง 2-3  การแกไขปญหาเกี่ยวกับดิสเก็ตต (ตอ)
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การแกไขปญหาเกี่ยวกับฮารดไดรฟ
ตาราง 2-4  การแกไขปญหาเกี่ยวกับฮารดไดรฟ

เกิดขอผิดพลาดของฮารดไดรฟ

สาเหตุ วิธีแกไข

ฮารดดิสกมีเซ็คเตอรที่เสียหายหรือใชงานไมได 1. ใน Windows XP คลิกขวาท่ี Start คลิก Explore และ
เลือกไดรฟ เลือก File > Properties > Tools ใต Error-
checking คลิก Check Now

2. ใชยูทิลิตีเพื่อคนหาตำแหนงและบล็อคการใชสวนที่เสีย หากจำเปน
ใหฟอรแมตฮารดดิสกใหม

เกิดขอผิดพลาดในการใชงานดิสก

สาเหตุ วิธีแกไข

โครงสรางไดเรคทอรีไมถกูตอง หรือไฟลมีปญหา ใน Windows XP คลิกขวาท่ี Start คลิก Explore และเลือกไดรฟ
เลือก File > Properties > Tools ใต Error-checking คลิก Check
Now

ไมพบไดรฟ (ท่ีระบุ)

สาเหตุ วิธีแกไข

สายเคเบิลอาจหลวม ตรวจสอบการตอสายเคเบิล

ระบบอาจไมรับทราบถึงไดรฟท่ีติดตั้งข้ึนใหมไดโดยอัตโนมัติ โปรดดูคำแนะนำในการตั้งคาใหมในหัวขอ การแกไขปญหาในการติดตั้ง
ฮารดแวร หากระบบยังไมรับรูถึงอุปกรณใหม ใหตรวจสอบวามีอุปกรณน้ัน
แสดงอยูภายในยูทิลิตีการต้ังคาคอมพิวเตอรหรือไม หากมีอยู สาเหตุของ
ปญหาอาจอยูท่ีไดรเวอร แตหากไมมีอุปกรณดังกลาวอยู ปญหาน้ีอาจเกิด
จากฮารดแวร

หากไดรฟนั้นเปนไดรฟท่ีติดตั้งใหม ใหรันยูทิลิตกีารตั้งคาคอมพิวเตอร
และลองเพิ่มระยะเวลาการรอในกระบวนการ POST ที่ Advanced >
Power-On Options

อุปกรณติดตั้งลงในพอรต SATA ท่ีไมถูกเปดใชงานในยูทิลิตีการตั้งคา
คอมพิวเตอร

รันยูทลิิตีการต้ังคาคอมพิวเตอร และโปรดตรวจสอบใหแนใจวาพอรตของ
อุปกรณ SATA เปดใชงานใน Storage > Storage Options

ไดรฟตอบสนองชาหลังจากการเริ่มตนระบบ รันยูทลิิตีการต้ังคาคอมพิวเตอร และเพิ่มเวลารอของกระบวนการ POST
ใน Advanced > Power-On Options

มีขอความ Nonsystem disk/NTLDR missing

สาเหตุ วิธีแกไข

ระบบพยายามเริ่มตนการทำงานจากแผนดิสเก็ตตที่บตูไมได นำแผนดิสเก็ตตน้ันออกจากไดรฟ

ระบบพยายามเริ่มตนการทำงานจากฮารดไดรฟ แตฮารดไดรฟอาจมีความ
เสียหาย

1. ใสแผนดิสเก็ตตท่ีบูตไดในดิสเกต็ตไดรฟและเริ่มระบบใหม

2. ตรวจสอบฟอรแมตของฮารดไดรฟโดยใช fdisk: หากเปนฟอรแมต
NTFS ใหใชเครื่องอานของผูผลิตอื่นเพ่ือประเมินไดรฟ หากเปน
ฟอรแมต FAT32 จะไมสามารถเขาถึงฮารดไดรฟดงักลาวได
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มีขอความ Nonsystem disk/NTLDR missing

สาเหตุ วิธีแกไข

ไฟลระบบขาดหายไปหรือไมไดติดตั้งอยางเหมาะสม 1. ใสแผนดิสเก็ตตท่ีบูตไดในดิสเกต็ตไดรฟและเริ่มระบบใหม

2. ตรวจสอบฟอรแมตของฮารดไดรฟ โดยใช Fdisk: หากเปน
ฟอรแมต NTFS ใหใชเคร่ืองอานของผูผลิตอื่นเพื่อประเมินไดรฟ
หากเปนฟอรแมต FAT32 จะไมสามารถเขาถึงฮารดไดรฟดังกลาว
ได

3. ติดต้ังไฟลระบบสำหรับระบบปฏิบัตกิารทีเ่หมาะสม

4. เรียกคืนระบบมาไวท่ีจุดการกูคืนใน HP Backup and Recovery
Manager สำหรับขอมูลเพ่ิมเติม โปรดดูท่ี คูมือผูใช HP Backup
and Recovery Manager ในเมนู Start ของ Windows

มีการตัดการบูตจากแผนฮารดไดรฟในยูทิลิตีการต้ังคาคอมพิวเตอร รันยูทิลิตีการตั้งคาคอมพิวเตอรและเลือกรายการฮารดไดรฟในรายการ
Storage > Boot Order

ไมไดเชื่อมตอฮารดไดรฟท่ีใชบูตไวเปนลำดับแรกในระบบที่มี
ฮารดไดรฟหลายตัว

หากพยายามจะบูตจากฮารดไดรฟ โปรดแนใจวาเช่ือมตอฮารดไดรฟกับ
ชองเสียบของเมนบอรด ท่ีมีเคร่ืองหมาย P60 SATA 0

คอนโทรลเลอรของฮารดไดรฟท่ีใชบูตไมอยูในรายการลำดับการบูต รันยูทิลิตีการตั้งคาคอมพิวเตอร แลวเลือก Storage > Boot Order และ
ตรวจสอบใหแนใจวาคอนโทรลเลอรของฮารดไดรฟที่ใชบูตปรากฏอยูใน
รายการ Hard Drive

คอมพิวเตอรจะไมบูตจากฮารดไดรฟ

สาเหตุ วิธีแกไข

อุปกรณติดต้ังลงในพอรต SATA ท่ีไมถูกเปดใชงานในยูทิลิตีการต้ังคา
คอมพิวเตอร

รันยูทิลิตีการตั้งคาคอมพิวเตอร และโปรดตรวจสอบใหแนใจวาพอรตของ
อุปกรณ SATA เปดใชงานใน Storage > Storage Options

ระบบการปฏิบัติการรุนเกาไมสนับสนุนอุปกรณบูตท่ีตอเขากับพอรต
SATA 4 หรือพอรต SATA

เช่ือมตออุปกรณบูตเขากับพอรต SATA 0 หรือพอรต SATA 1

ลำดับการบูตไมถูกตอง รันยูทิลิตีการตั้งคาคอมพิวเตอร แลวเปล่ียนลำดับการบูตใน Storage >
Boot Order

“Emulation Type" ของฮารดไดรฟถูกตั้งเปน "None" รันยูทิลิตีการตั้งคาคอมพิวเตอร และเปลี่ยน "Emulation Type" เปน
"Hard Disk" ในรายละเอียดของอุปกรณใต Storage > Device
Configuration

อุปกรณติดต้ังลงในพอรต SATA ท่ีไมถูกเปดใชงานในยูทิลิตีการต้ังคา
คอมพิวเตอร

รันยูทิลิตีการตั้งคาคอมพิวเตอร และโปรดตรวจสอบใหแนใจวาพอรตของ
อุปกรณ SATA เปดใชงานใน Storage > Storage Options

ฮารดไดรฟเกิดความเสียหาย สังเกตวาไฟสถานะเปดเครื่องท่ีแผงดานหนากะพรบิเปนสีแดง และมี
สัญญาณเสียงดังข้ึน โปรดดูภาคผนวก A ขอความแสดงขอผิดพลาดของ
POST เพื่อระบุสาเหตุท่ีเปนไปไดสำหรับไฟกะพริบสีแดงและรหัสเสียง

โปรดดูขอกำหนดและเงื่อนไขสำหรับการรับประกันแบบจำกัดท่ัวโลก

คอมพิวเตอรเหมือนจะคาง

สาเหตุ วิธีแกไข

โปรแกรมที่ใชอยูหยุดตอบสนองตอคำสั่งตางๆ ปดคอมพิวเตอรตามขั้นตอนปกติของ Windows หากไมสามารถปดเคร่ือง
ได กดปุมเพาเวอรคางไวเปนเวลาสี่วินาทีหรือเกนิกวาน้ันพ่ือปดคอม
พิวเตอร ในการรีสตารทคอมพิวเตอร กดปุมเพาเวอรอีกครั้ง

ตาราง 2-4  การแกไขปญหาเกี่ยวกับฮารดไดรฟ (ตอ)
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การแกไขปญหาตัวอานการดมีเดีย
ตาราง 2-5  การแกไขปญหาตัวอานการดมีเดีย

การดมีเดียจะไมทำงานในกลองดิจิตอลหลังจากฟอรแมทใน Microsoft Windows XP

สาเหตุ วิธีแกไข

ตามคาดีฟอลตน้ัน Windows XP จะฟอรแมทการดมีเดียใดๆ ที่มีความจุ
เกิน 32MB ดวยรูปแบบ FAT32 กลองดิจิตอลสวนใหญใชรูปแบบ FAT
(FAT16 และ FAT12) และไมสามารถทำงานกับการดท่ีถูกฟอรแมทแบบ
FAT32

ใหฟอรแมทการดมีเดียท่ีอยูในกลองดิจิตอล หรือเลือกระบบไฟล FAT เพ่ือ
ฟอรแมทการดมีเดียท่ีอยูในคอมพิวเตอรดวย Windows XP

เกิดขอผิดพลาดปองกันการเขียนหรือขอผิดพลาดการล็อคในขณะท่ีพยายามเขียนบนการดมีเดีย

สาเหตุ วิธีแกไข

การดมีเดียถูกล็อค การล็อคการดมีเดียคือคุณสมบัตดิานความปลอดภัยท่ี
ปองกันการเขียนและการลบออกจากการด SD/Memory Stick/PRO

หากใชการด SD ควรดูใหแนใจวา แท็บล็อคท่ีดานขวาของการด SD ไมได
อยูในตำแหนงล็อค หากใชการด Memory Stick/PRO ควรดูใหแนใจวา
แท็บล็อคทีด่านลางของการด Memory Stick/PRO ไมไดอยูใน
ตำแหนงล็อค

ไมสามารถเขียนลงในการดมีเดียได

สาเหตุ วิธีแกไข

การดมีเดียเปนการดหนวยความจำ (ROM) แบบอานอยางเดียว ตรวจสอบจากเอกสารประกอบของผูผลิตท่ีมาพรอมกับการดเพ่ือดูวาการด
น้ีเปนแบบเขียนลงไปไดหรือไม

ไมสามารถเขาถึงขอมูลท่ีอยูบนการดมีเดียหลังจากใสการดลงในสล็อต

สาเหตุ วิธีแกไข

ใสการดมีเดียไมเหมาะสม ใสลงในสล็อตท่ีไมถูกตอง หรือระบบไมรองรับ
การดมีเดียดังกลาว

ดูใหแนใจวา ไดใสการดไดอยางเหมาะสม โดยหนาสัมผัสสีทองอยูในดานท่ี
ถูกตอง ไฟสีเขียวจะสวางข้ึนหากใสการดไดอยางถูกตอง

ไมทราบวิธีถอดการดท่ีถูกตอง

สาเหตุ วิธีแกไข

ใชซอฟตแวรของคอมพิวเตอรเพ่ือดีดการดออกอยางปลอดภยั เปด My Computer คลิกขวาที่ไอคอนไดรฟท่ีเก่ียวของ และเลือก Eject
กอนดึงการดออกจากสล็อต

หมายเหตุ หามดึงการดในขณะท่ีไฟสีเขียวกะพริบ

หลังจากติดต้ังตัวอานการดมีเดียและบูตไปท่ี Windows แลว คอมพิวเตอรไมรับรูถึงตัวอานและการดท่ีใสลงไป

สาเหตุ วิธีแกไข

ระบบปฏิบัติการตองการเวลาเพื่อรับรูถึงอุปกรณนัน้ หากเพิ่งติดตั้งตัวอาน
ลงในคอมพิวเตอร และคุณเปดคอมพิวเตอรเปนคร้ังแรก

รอประมาณ 1-2 วินาทีเพ่ือใหระบบปฏิบัติการรับรูถึงตัวอานและพอรตท่ีนำ
มาใชได กอนรับรูวา คุณใสมีเดียใดลงในตัวอาน
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หลังจากใสการดมีเดียลงในตัวอาน คอมพิวเตอรพยายามบูตจากการดมีเดีย

สาเหตุ วิธีแกไข

การดมีเดียท่ีใสในคอมพิวเตอรสามารถใชบูตได หากคุณไมตองการบูตจากการดมีเดีย ใหถอดการดออกในระหวางท่ีบูต
หรือไมเลือกตัวเลือกเพือ่บูตจากการดมีเดียที่ใสไวในระหวางขั้นตอนการ
บูต

คอมพิวเตอรจะไมบูตจากไดรฟ USB ท่ีถอดออกได หรือมีเดียท่ีใสลงในพอรต USB บนตัวอานการดมีเดีย

สาเหตุ วิธีแกไข

ตัวอานการดมีเดียถูกเช่ือมตอเขากับคอมพิวเตอรผานทางการด PCI ที่ไม
รองรับบนระบบ BIOS ของ HP Desktop

อุปกรณ USB ท่ีสามารถใชบูตไดจะมีการรองรับการบูต ถาคุณไดเชื่อมตอ
ตัวอานการดมีเดียเขากับชองเสียบ USB ในเมนบอรดของเคร่ือง
คอมพิวเตอร หากไมมีชองเสียบ ใหเสียบปล๊ักของอุปกรณการบูตลงใน
พอรตวิดีโอพอรต USB อื่นบนคอมพิวเตอรหากมีพอรตน้ัน

หลังจากติดต้ังตัวอานการดมีเดีย พอรต USB ดานหนาของคอมพิวเตอรไมทำงาน

สาเหตุ วิธีแกไข

สายเคเบิล USB สำหรับพอรต USB ดานหนาถูกถอดออก เพ่ือใหใชชอง
เสียบเมนบอรดสำหรับตัวอานแทน

ตอสายเคเบิลสำหรับพอรต USB ดานหนากลับเขาไปใหม ใสการด PCI
และตอตัวอานการดเขากับชองเสียบ USB บนการด PCI

ตาราง 2-5  การแกไขปญหาตัวอานการดมีเดีย (ตอ)
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การแกไขปญหาเกี่ยวกับการแสดงผล
หากคุณพบปญหาเกี่ยวกับการแสดงผลบนจอภาพ โปรดอานเอกสารที่มาพรอมกับหนาจอหรือดูสาเหตุและการแกไขปญหาที่
พบบอยในตารางตอไปนี้

ตาราง 2-6  การแกไขปญหาเกี่ยวกับการแสดงผล

หนาจอวางเปลา (ไมมีการแสดงผล)

สาเหตุ วิธีแกไข

ไมไดเปดหนาจอ ไฟหนาจอไมติด เปดหนาจอ และดูวาไฟหนาจอติด

จอภาพไมดี ลองเปลี่ยนไปใชจอภาพอื่น

ตอสายเคเบิลไมถูกตอง ตรวจสอบการตอสายเคเบิลจากจอภาพไปยังเคร่ืองคอมพิวเตอร และสาย
ไฟที่เสียบเขากับเตารับไฟฟา

คุณอาจติดตัง้ยูทิลิตีปดหนาจอหรือมีการใชคุณสมบัติประหยัดพลังงาน กดปุมใดๆ ก็ไดบนแปนพิมพหรือคลิกปุมเมาส และปอนรหัสผานหากมีการ
กำหนดไว

ROM ของระบบเสียหาย ระบบกำลังรันในโหมดกูคืนฉุกเฉินบล็อคการบูต
(ซึ่งระบุจากสัญญาณเสียงแปดครั้ง)

แฟลช ROM ของระบบอีกครั้ง ดวยอิมเมจลาสุดของ BIOS โปรดดูราย
ละเอียดเพ่ิมเติมในหัวขอ “โหมดกูคืนฉุกเฉินบล็อคการบูต” ใน คูมือการ
จัดการเดสกทอป ใน แผนซีดี Documentation and Diagnostics

คุณใชจอภาพท่ีมีการซิงโครไนซคงท่ี และไมสามารถซิงโครไนซทีค่วาม
ละเอียดท่ีเลือกไว

ตรวจสอบวาจอภาพสามารถรองรับอัตราการกวาดภาพที่เหมือนกับอัตรา
ความละเอียดท่ีเลือกไว

คอมพิวเตอรอยูในโหมด สแตนดบาย กดปุมเพาเวอรเพื่อออกจากโหมด สแตนดบาย

ขอควรระวัง เมื่อพยายามจะทำงานตอจากโหมด สแตนดบาย
อยากดปุมเพาเวอรนานเกินสี่วินาที มิฉะนั้น คอมพิวเตอรจะปด
ลง และคุณจะสูญเสียขอมูลท่ียังไมไดจัดเก็บ

สายเคเบิลของจอภาพเสียบกับพอรตที่ไมถูกตอง ดูใหแนใจวา ไดเสียบปล๊ักมอนิเตอรเขากับชองเสียบท่ีใชงานอยูที่ดานหลัง
ของคอมพิวเตอรแลว หากมีชองเสียบอื่นวางอยู ใหตอสายมอนิเตอรเขากับ
ชองเสียบน้ันแลวจึงรีบูตเคร่ือง

การตั้งคาจอภาพในเครื่องคอมพิวเตอรไมตรงกับจอภาพที่ใช 1. รีสตารทคอมพิวเตอร และกด F8 ในระหวางเริ่มตนระบบ เมื่อคุณ
เห็นขอความ “Press F8” ท่ีมุมขวาลางของหนาจอ

2. ใชปุม ลูกศร บนแปนพิมพเพื่อเลือก Enable VGA Mode แลวกด
Enter

3. ใน Control Panel ของ Windows ใหดับเบิลคลิกท่ีไอคอน
Display แลวเลือกแท็บ Settings

4. ปรับแถบเลื่อนเพื่อตั้งคาความละเอียดใหม

ไมสามารถเปดใชกราฟกภายในหลังจากติดต้ังการดแสดงผล PCI-Express

สาเหตุ วิธีแกไข

ชองเสียบ SDVO/PCI บนเมนบอรดมีรูปลักษณภายนอกเหมือนกับชอง
เสียบ PCI Express x16 แตแพลตฟอรมไมสนับสนุนการใชการด PCI
Express แบบคอนเวนชันนอลหรือการดเคาโครงพิเศษ (หรือ reversed-
layout) ADD2

แพลตฟอรมสนับสนนุเฉพาะการใชงานเคาโครงปกติ (หรือ non-
reversed) การดอะแดปเตอร ADD2 (Advanced Digital Display
SDVO) ใสเขากับชองเสียบ SDVO (Serial Digital Video Output) ท่ี
แพลตฟอรมของเมนบอรด การด ADD2 ท่ีเคยใชเพื่อใหความสามารถ
มอนิเตอรเอนกประสงคกับคอนโทรลเลอรกราฟกภายใน
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หนาจอวางเปลา ไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 5 ครั้งทุกๆ วินาที จากน้ันเวน 2 วินาที และคอมพิวเตอรสงสัญญาณเสียง 5 คร้ัง (เสียงเตือนจะหยุด
หลังจากดังติดตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

หนวยความจำการแสดงผลเกิดขอผดิพลาด 1. ใส DIMM ใหมอีกคร้ัง เปดเคร่ืองคอมพิวเตอร

2. เปล่ียน DIMM ทีละชิ้น เพื่อแยกโมดูลท่ีมีขอผิดพลาดออก

3. ใชหนวยความจำของ HP แทนหนวยความจำของผูผลิตรายอื่น

4. เปล่ียนเมนบอรด

หนาจอวางเปลา ไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 6 ครั้งทุกๆ วินาที จากน้ันเวน 2 วินาที และคอมพิวเตอรสงสัญญาณเสียง 6 คร้ัง (เสียงเตือนจะหยุด
หลังจากดังติดตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

การแสดงผลมขีอผิดพลาด สำหรับระบบท่ีใชการดแสดงผล:

1. ติดต้ังการดแสดงผลใหม เปดเคร่ืองคอมพิวเตอร

2. เปล่ียนการดแสดงผล

3. เปล่ียนเมนบอรด

สำหรับระบบท่ีใชกราฟกภายใน ใหเปลี่ยนเมนบอรด

หนาจอวางเปลา ไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 7 ครั้งทุกๆ วินาที จากน้ันเวน 2 วินาที และคอมพิวเตอรสงสัญญาณเสียง 7 คร้ัง (เสียงเตือนจะหยุด
หลังจากดังติดตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

เมนบอรดขัดของ (ROM ตรวจพบการขัดของกอนการแสดงผล). เปล่ียนเมนบอรด

จอภาพไมทำงานตามปกติเมื่อใชคุณสมบัติประหยัดพลังงาน

สาเหตุ วิธีแกไข

มีการใชคุณสมบัติประหยัดพลังงานกบัจอภาพที่ไมสามารถใชคุณสมบัติดัง
กลาวได

ยกเลิกการใชงานคุณสมบัติประหยัดพลังงาน

ตัวอักษรไมชัดเจน

สาเหตุ วิธีแกไข

มีการปรับความสวางและความเขมของจอภาพอยางไมถูกตอง ปรับปุมควบคุมความสวางและความเขมของจอภาพ

ตอสายเคเบิลไมถูกตอง ตรวจสอบวาสายของจอภาพตอเขากับการดแสดงผลอยางถูกตอง

ตาราง 2-6  การแกไขปญหาเกี่ยวกับการแสดงผล (ตอ)
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ภาพมัวและไมสามารถกำหนดความละเอียดที่ตองการ

สาเหตุ วิธีแกไข

หากมีการอัพเกรดคอนโทรลเลอรการแสดงผล คุณจะตองโหล
ดไดรเวอรการแสดงผลท่ีถูกตอง

ติดตั้งไดรเวอรการแสดงผลจากดิสเก็ตตที่มาพรอมกับชุดอัพเกรด

จอภาพไมสามารถแสดงความละเอียดตามที่ตองการได เปลี่ยนความละเอียดท่ีต้ังคาไว

การดแสดงผลไมดี เปลี่ยนการดแสดงผล

ภาพลม ไมเรียบ เปนรอยหยัก หรือกะพริบ

สาเหตุ วิธีแกไข

การเชื่อมตอจอภาพไมสมบูรณหรืออาจมีการต้ังคาจอภาพที่ไมถูกตอง 1. ตรวจสอบสายเคเบิลของจอภาพวาตอกับคอมพิวเตอรอยางแนนหนา

2. ในระบบสองจอภาพหรือหากมีจอภาพอื่นอยูใกลๆ โปรดตรวจสอบวา
ท้ังสองจอภาพไมรบกวนการทำงานซึ่งกนัและกัน โดยยายจอภาพทั้ง
สองออกหางจากกัน

3. จอภาพอยูใกลหลอดไฟหรือพัดลมมากเกินไป

จำเปนตองลางสนามแมเหล็กใหกับจอภาพ ลางสนามแมเหล็กใหกับจอภาพ โปรดดคูำแนะนำในเอกสารที่มาพรอมกับ
จอภาพ

ภาพไมอยูตรงกลาง:

สาเหตุ วิธีแกไข

อาจจำเปนตองปรับตำแหนง กดปุม Menu เพ่ือเขาสูเมนู OSD เลือก ImageControl/ Horizontal
Position หรือ Vertical Position เพื่อปรับตำแหนงตามแนวนอนหรือ
แนวตั้งของภาพ

ขอความ “No Connection, Check Signal Cable” แสดงขึ้นที่หนาจอ

สาเหตุ วิธีแกไข

สายเคเบิลวิดีโอของจอภาพถูกตัดการเช่ือมตอ เชื่อมตอสายเคเบิลวิดีโอระหวางจอภาพและคอมพิวเตอร

ขอควรระวัง ดูใหแนใจวาปดไฟเคร่ืองแลวเมื่อเชื่อมตอสาย
เคเบิลวิดีโอ

ขอความ “Out of Range” แสดงข้ึนท่ีหนาจอ

สาเหตุ วิธีแกไข

ความละเอียดวิดีโอและอัตรารีเฟรชตัง้ไวสูงกวาท่ีจอภาพรองรับ เริ่มตนคอมพิวเตอรใหมและเขาสู Safe Mode เปล่ียนการต้ังคาใหเปนคา
ท่ีรองรับ จากน้ันเริ่มตนคอมพิวเตอรใหมเพ่ือใหการต้ังคาใหมมีผล

ตาราง 2-6  การแกไขปญหาเกี่ยวกับการแสดงผล (ตอ)
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มีเสียงสั่นรัวดังมาจากขางในของจอภาพ CRT ในขณะเปดเคร่ือง

สาเหตุ วิธีแกไข

ขดลวดลางสนามแมเหล็กในจอภาพกำลังทำงาน ไมมี ตามปกติแลว ขดลวดลางสนามแมเหล็กจะทำงานเมือ่คุณเปดจอภาพ

มีเสียงคลิกดังมาจากขางในของจอภาพ CRT

สาเหตุ วิธีแกไข

รีเลยอิเล็กทรอนิกสในจอภาพกำลังทำงาน ไมมี ตามปกติแลว จอภาพบางรุนจะมีเสียงดงัคลิกเมื่อคุณเปดและปดเครื่อง
เมื่อเขาสูและออกจากโหมดสแตนดบาย และเมื่อมีการเปลี่ยนคาความ
ละเอียด

มีเสียงแหลมดังมาจากขางในของจอภาพแบบเรียบ

สาเหตุ วิธีแกไข

ความสวางและหรือความเขมสูงเกินไป ลดความสวางและหรอืความเขม

ภาพไมคมชัด ภาพเปรอะ ภาพซอน หรือมีเงา มีเสนว่ิงในแนวนอน มีแถบจางๆ ในแนวตั้ง หรือไมสามารถกำหนดจุดศูนยกลางของภาพบนหนาจอ (เฉพาะ
จอภาพแบบเรียบที่ใชการเชื่อมตอสัญญาณอินพุต VGA แบบอะนาล็อก)

สาเหตุ วิธีแกไข

วงจรการแปลงสัญญาณดิจิตอลภายในจอภาพแบบเรียบอาจไมสามารถตี
ความสัญญาณซิงโครไนซที่มาจากการดแสดงผล

1. เลือกตัวเลือก Auto-Adjustment ในเมนูการแสดงผลท่ีปรากฏบน
หนาจอ

2. ทำการซิงโครไนซฟงกชัน Clock และ Clock Phase ที่แสดงบน
หนาจอ คุณสามารถดาวนโหลด SoftPaq สำหรับการซิงโครไนซ
โดยไปยังเว็บไซตดานลางนี้ แลวเลือกจอภาพที่เหมาะสม และ
ดาวนโหลด SP32347 หรือ SP32202: http://www.hp.com/
support

การดแสดงผลไมดีหรือไมไดรับการติดตั้งอยางเหมาะสม 1. ติดต้ังการดแสดงผลใหม

2. เปล่ียนการดแสดงผล

สัญลักษณบางตัวท่ีพิมพไมตรงกับท่ีปรากฏบนหนาจอ

สาเหตุ วิธีแกไข

แบบอักษรท่ีคุณใชไมสนับสนุนสัญลักษณน้ันๆ ใช Character Map เพ่ือคนหาและเลือกสัญลักษณที่คุณตองการ คลิก
Start > All Programs > Accessories > System Tools >
Character Map คุณสามารถคัดลอกสัญลักษณท่ีตองการจาก
Character Map ไปใสไวในเอกสาร

ตาราง 2-6  การแกไขปญหาเกี่ยวกับการแสดงผล (ตอ)
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การแกไขปญหาเกี่ยวกับระบบเสียง
หากคอมพิวเตอรของคุณสามารถใชงานเกี่ยวกับเสียงได และคุณพบปญหาเกี่ยวกับระบบเสียง โปรดดูสาเหตุและการแกไข
ปญหาในตารางตอไปนี้

ตาราง 2-7  การแกไขปญหาเกี่ยวกับระบบเสียง

เสียงขาดๆ หายๆ

สาเหตุ วิธีแกไข

โปรเซสเซอรกำลังถูกใชในการประมวลผลโปรแกรมอื่นท่ีเปดอยู ปดโปรแกรมที่ตองอาศัยการประมวลผลอยางมาก

ความลาชาของเสียง พบไดทั่วไปในโปรแกรมเลนสื่อ ใน Windows XP:

1. ใน Control Panel ใหเลือก Sounds and Audio Devices

2. บนแท็บ Audio ใหเลือกอุปกรณจากรายการ Sound Playback

3. คลิกปุม Advanced แลวเลือกแท็บ Performance

4. ปรับแถบเลื่อน Hardware acceleration ไปท่ี None และปรับ
แถบเลื่อน Sample rate conversion quality ไปท่ี Good จาก
น้ันใหลองทดสอบเสียงอีกคร้ัง

5. ปรับแถบเลื่อน Hardware acceleration ไปท่ี Full และปรับแถบ
เลื่อน Sample rate conversion quality ไปท่ี Best จากน้ันให
ลองทดสอบเสียงอีกครั้ง

ไมมีเสียงออกจากลำโพงหรือหูฟง

สาเหตุ วิธีแกไข

มีการลดระดับเสียงดวยซอฟตแวร ดับเบิลคลิกท่ีไอคอนรูป ลำโพง บนทาสกบาร จากน้ันตรวจดูวาตัวเลือก
Mute ไมไดถูกเลือก และปรับระดับเสียงโดยเล่ือนแถบปรับระดับเสียง

เสียงถูกซอนอยูในยูทิลิตีการตั้งคาคอมพิวเตอร เปดใชงานเสียงในยูทิลิตีการต้ังคาคอมพิวเตอร: Security > Device
Security > Audio

ไมไดเปดลำโพง เปดลำโพง

อาจตอสายอุปกรณเสียงเขากับแจ็คท่ีอยูท่ีดานหลังของคอมพิวเตอรผิดอนั
หรือสายแจ็คถูกปรับใหทำงานในฟงกชันท่ีตางออกไป

ดูใหแนใจวา ไดตออุปกรณเขากับแจ็คท่ีถูกตองทีด่านหลังของคอมพิวเตอร
ถาใชแจ็คที่ถูกตองแลวและยังคงมีปญหาอยู แสดงวา แจ็คอาจถูกปรับเพื่อ
ใหทำงานในฟงกชันท่ีตางจากฟงกชันเร่ิมตน เปดแผงควบคุม Realtek
โดยการคลิกท่ีไอคอน Realtek HD Audio Manager ในถาดงานหรือ
รายการ Realtek ในแผงควบคุมของระบบปฏบิัติการและต้ังคา
แจ็คใหทำงานในฟงกชันท่ีตองการ

ตอลำโพงภายนอกเขากับแจ็คเสียงท่ีอยูบนการดเสียงทีเ่พิ่งติดตั้งผิดอัน ดูเอกสารที่มาพรอมกับการดเสียงเพื่อดูการตอลำโพงที่ถูกตอง

ไมไดเปดใชระบบเสียงดิจิตอลซีดี เปดใชระบบเสียงดิจิตอลซีด:ี

1. ใน Control Panel เลือก System

2. บนแท็บ Hardware ใหคลิกท่ีปุม Device Manager

3. คลิกขวาท่ีอุปกรณซีดี/ดีวีดี และเลือก Properties

4. บนแท็บ Properties ตรวจดูวามีการเลือก Enable digital CD
audio for this CD-ROM device

หูฟงหรืออุปกรณที่ตอเขากับชองเสียบสัญญาณเสียงออกทำใหลำโพงภาย
ในระบบไมมีเสียง

เปดและใชหูฟงหรือลำโพงภายนอกหากตอไว หรือถอดอุปกรณเหลาน้ีออก
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ไมมีเสียงออกจากลำโพงหรือหูฟง

สาเหตุ วิธีแกไข

มีการปดเสียง 1. ใน Control Panel คลิก Sound, Speech and Audio
Devices จากน้ันคลิก Sounds and Audio Devices

2. คลิกเช็คบ็อกซ Mute เพ่ือลบเครื่องหมายออกจากบ็อคซ

คอมพิวเตอรอยูในโหมด สแตนดบาย กดปุมเพาเวอรเพ่ือออกจากโหมด สแตนดบาย

ขอควรระวัง เมื่อพยายามจะทำงานตอจากโหมด สแตนดบาย
อยากดปุมเพาเวอรนานเกินสี่วินาที มิฉะนั้น คอมพิวเตอรจะปด
ลง และคุณจะสูญเสียขอมูลท่ียังไมไดจัดเก็บ

เสียงจากหูฟงไมชัดหรืออูอี้

สาเหตุ วิธีแกไข

หูฟงถูกเสียบเขาที่ชองเสียงสัญญาณเสียงออกท่ีดานหลัง ชองเสียงสัญญาณ
เสียงออกทีด่านหลังใชสำหรับอุปกรณเสียงท่ีมีกำลังไฟ และไมไดออกแบบ
ใหใชกับหูฟง

เสียบหูฟงท่ีชองเสียบหูฟงดานหนาของเคร่ือง

คอมพิวเตอรคางในระหวางการบันทึกเสียง

สาเหตุ วิธีแกไข

ฮารดดิสกอาจเต็ม กอนที่จะบันทึกเสียง ใหตรวจดูวามีเน้ือท่ีวางบนฮารดดิสกเพียงพอ หรือคุณ
อาจใชวิธีบันทึกไฟลเสียงในรูปแบบบีบอดัขอมูล

แจ็คของสัญญาณเสียงเขา สัญญาณเสียงออก เฮดโฟน หรือของไมโครโฟนทำงานไมเหมาะสม

สาเหตุ วิธีแกไข

มีการกำหนดคาใหมใหกับแจ็คในไดรเวอรระบบเสียงหรือซอฟตแวร แอ
ปพลิเคชัน

เมื่ออยูในไดรเวอรระบบเสยีงหรือซอฟตแวรแอปพลิเคชัน ใหกำหนดคา
ใหมใหกับแจ็คหรือตั้งคาแจ็คกลับเปนคาดีฟอลต

ตาราง 2-7  การแกไขปญหาเกี่ยวกับระบบเสียง (ตอ)
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การแกไขปญหาของเครื่องพิมพ
หากคุณพบปญหาเกี่ยวกับเครื่องพิมพ โปรดอานเอกสารที่มาพรอมกับเคร่ืองพิมพ และรายการสาเหตุและการแกไขปญหาที่
พบบอยในตารางตอไปนี้

ตาราง 2-8  การแกไขปญหาของเครื่องพิมพ

เครื่องพิมพไมทำงาน

สาเหตุ วิธีแกไข

ไมไดเปดเครือ่งพิมพหรือเคร่ืองไมอยูในโหมดออนไลน เปดเคร่ืองพิมพและตรวจสอบวาอยูในโหมดออนไลนแลว

ไมไดติดต้ังไดรเวอรเครื่องพิมพเวอรชันท่ีถูกตอง 1. ติดตั้งไดรเวอรในเวอรชันที่ถูกตองสำหรับแอปพลิเคชันของคณุ

2. ลองพิมพโดยใชคำสั่งของ MS-DOS:

DIR C:\ > LPT1

หากเครื่องพิมพทำงาน ใหโหลดไดรเวอรของเคร่ืองพิมพใหม

หากคุณอยูในเน็ตเวิรก คุณอาจไมมีการเช่ือมตอไปยังเคร่ืองพิมพ ทำการเช่ือมตอไปยังเครื่องพิมพ

เคร่ืองพิมพอาจขัดของ รันการทดสอบโดยอัตโนมัติของเคร่ืองพิมพ

ไมสามารถเปดเครื่องพิมพ

สาเหตุ วิธีแกไข

ตอสายไมถูกตอง ตอสายเคเบิลท้ังหมดอีกคร้ังและตรวจสอบสายไฟและปลั๊กเสียบ

เครื่องพิมพพิมพขอมูลท่ีอานไมออก

สาเหตุ วิธีแกไข

ไมไดติดต้ังไดรเวอรเครื่องพิมพเวอรชันท่ีถูกตอง ติดตั้งไดรเวอรในเวอรชันที่ถูกตองสำหรับแอปพลิเคชันของคณุ

ตอสายไมถูกตอง ตอสายเคเบิลท้ังหมดอีกคร้ัง

อาจมีการใชงานหนวยความจำของเครื่องพิมพมากเกินไป รีเซ็ตเคร่ืองพิมพดวยการปดเปนเวลา 1 นาที และเปดใหมอีกคร้ัง

เครื่องพิมพอยูในสถานะออฟไลน

สาเหตุ วิธีแกไข

กระดาษในเครื่องพิมพอาจหมด ตรวจสอบถาดปอนกระดาษและเติมกระดาษใหเต็ม เลือกโหมดออนไลน

28 บท 2   การแกไขปญหาโดยไมผานโปรแกรมวินิจฉัย THWW



การแกไขปญหาเกี่ยวกับแปนพิมพและเมาส
หากคุณพบปญหาเกี่ยวกับแปนพิมพหรือเมาส โปรดอานเอกสารที่มาพรอมกับอุปกรณและดูรายการสาเหตุและการแกไข
ปญหาโดยทั่วไปในตารางตอไปนี้

ตาราง 2-9  การแกไขปญหาเกี่ยวกับแปนพิมพ

คอมพิวเตอรไมรับรูคำสั่งจากแปนพิมพและการพิมพ

สาเหตุ วิธีแกไข

ตอสายเขากับชองเสียบแปนพิมพไมถูกตอง 1. คลิก Start บนเดสกทอป Windows

2. คลิก Shut Down ไดอะล็อกบ็อกซ Shut Down Windows จะ
ปรากฏข้ึน

3. เลือก Shut down

4. หลังจากปดเคร่ืองเรียบรอยแลว เสียบสายแปนพิมพเขากับ
คอมพิวเตอรใหมอีกครั้งและรีสตารทคอมพิวเตอร

โปรแกรมที่ใชอยูหยุดตอบสนองตอคำสั่งตางๆ ปดคอมพิวเตอรของคุณ โดยใชเมาส จากน้ันรีสตารทคอมพิวเตอร

อาจตองซอมแปนพิมพ โปรดดูขอกำหนดและเงื่อนไขสำหรับการรับประกันแบบจำกัดท่ัวโลก

ขอผดิพลาดอุปกรณไรสาย 1. ตรวจสอบซอฟตแวร หาหมี เพื่อดูสถานะของอุปกรณ

2. ตรวจสอบ/เปล่ียนแบตเตอรี่ของอุปกรณ

3. รีเซ็ตตัวรับและแปนพิมพ

คอมพิวเตอรอยูในโหมด สแตนดบาย กดปุมเพาเวอรเพ่ือออกจากโหมด สแตนดบาย

ขอควรระวัง เมื่อพยายามจะทำงานตอจากโหมด สแตนดบาย
อยากดปุมเพาเวอรนานเกินสี่วินาที มิฉะนั้น คอมพิวเตอรจะปด
ลง และคุณจะสูญเสียขอมูลท่ียังไมไดจัดเก็บ

เคอรเซอรไมเคลื่อนไหวเมื่อใชปุม ลูกศร บนแปนพิมพ

สาเหตุ วิธีแกไข

ปุม Num Lock อาจอยูในสถานะใชงาน กดปุม Num Lock ไฟสถานะ Num Lock ไมควรจะเปดอยูหากคุณตอง
การใชปุม ลูกศร สามารถเปด (หรือปดการใชงาน) ปุม Num Lock ไดใน
ยูทิลิตีการต้ังคาคอมพวิเตอร

ตาราง 2-10  การแกไขปญหาเมาส

เมาสไมตอบสนองตอการเคลื่อนไหวหรือตอบสนองชาเกินไป

สาเหตุ วิธีแกไข

เสียบสายเมาสเขากบัเคร่ืองคอมพิวเตอรไมถูกตอง ปดคอมพิวเตอรของคุณโดยใชแปนพิมพ

1. กดปุม Ctrl และ Esc พรอมกัน (หรือกดปุม Windows logo) เพ่ือ
เขาสูเมนู Start

2. ใชปุม ลูกศรข้ึน หรือ ลูกศรลง เพ่ือเลือก Shut Down จากน้ันกด
ปุม Enter
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เมาสไมตอบสนองตอการเคลื่อนไหวหรือตอบสนองชาเกินไป

สาเหตุ วิธีแกไข

3. ใชปุม ลูกศรขึ้น หรือ ลูกศรลง เพื่อเลือกตัวเลือก Shut Down จาก
น้ันกดปุม Enter

4. หลังจากปดเคร่ืองเรียบรอยแลว เสียบเมาสเขากับดานหลังของ
คอมพิวเตอร (หรือแปนพิมพ) และรีสตารทคอมพิวเตอร

โปรแกรมที่ใชอยูหยุดตอบสนองตอคำสั่งตางๆ ปดคอมพิวเตอรของคุณ โดยใชแปนพิมพ จากนั้นรีสตารทคอมพิวเตอร

อาจจำเปนตองทำความสะอาดเมาส ถอดฝาครอบลูกกลิ้งจากดานลางของเมาสออก และทำความสะอาดสวน
ประกอบภายใน

อาจจำเปนตองซอมแซมเมาส โปรดดูขอกำหนดและเงื่อนไขสำหรับการรับประกันแบบจำกัดท่ัวโลก

ขอผิดพลาดอุปกรณไรสาย 1. ตรวจสอบซอฟตแวร หาหมี เพื่อดูสถานะของอุปกรณ

2. ตรวจสอบ/เปล่ียนแบตเตอรี่ของอุปกรณ

3. รีเซ็ตตัวรับและเมาส

คอมพิวเตอรอยูในโหมด สแตนดบาย กดปุมเพาเวอรเพื่อออกจากโหมด สแตนดบาย

ขอควรระวัง เมื่อพยายามจะทำงานตอจากโหมด สแตนดบาย
อยากดปุมเพาเวอรนานเกินสี่วินาที มิฉะนั้น คอมพิวเตอรจะปด
ลง และคุณจะสูญเสียขอมูลท่ียังไมไดจัดเก็บ

เมาสเคลื่อนในแนวตั้งหรือแนวนอนเทาน้ัน หรือมีการกระตุก

สาเหตุ วิธีแกไข

บอลลูกกล้ิงของเมาสหรือแกนตัวถอดรหัสท่ีกำลังหมุนที่สัมผัสกับเมาส
สกปรก

ถอดฝาครอบลูกกลิ้งจากดานลางของเมาสออกและทำความสะอาดสวน
ประกอบภายในดวยชุดทำความสะอาดเมาสท่ีมีขายในรานคอมพิวเตอรท่ัว
ไป

ตาราง 2-10  การแกไขปญหาเมาส (ตอ)
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การแกไขปญหาในการติดต้ังฮารดแวร
คุณอาจตองตั้งคาคอมพิวเตอรใหมเมื่อคุณเพ่ิมหรือถอดฮารดแวร เชน ไดรฟหรือการดเอ็กซแพนชันเพิ่มเติม หากคุณติดตั้ง
อุปกรณแบบพลักแอนดเพลย Windows XP จะรับรูถึงอุปกรณน้ันและตั้งคาคอนฟเกอเรชันของระบบไดโดยอัตโนมัติ หาก
คุณติดตั้งอุปกรณที่ไมใชแบบพลักแอนดเพลย คุณจะตองต้ังคาระบบคอมพิวเตอรใหมหลังจากติดตั้งฮารดแวร ใน Windows
XP ใหใช Add Hardware Wizard และปฏิบัติตามคำแนะนำบนหนาจอ

คำเตือน! เม่ือตอสายไฟกับเครื่องคอมพิวเตอร แหลงจายไฟจะมีแรงดันไฟฟาสำหรับเมนบอรดอยูตลอดเวลา เพ่ือ
ลดความเสี่ยงที่จะไดรับบาดเจ็บจากไฟฟาช็อต และ/หรือพื้นผิวที่รอน คุณควรตรวจดูใหแนใจวา ไดถอดปลั๊กไฟแลว
และปลอยใหสวนประกอบภายในของระบบเย็นกอนจะสัมผัส

ใหมองไปที่ไฟ LED ในเมนบอรด ในกรณีที่ไฟ LED สวาง แสดงวาเมนบอรดยังคงมีกระแสไฟอยู ปดเครื่อง
คอมพิวเตอรและถอดปลั๊กออกกอนจะดำเนินการตอ

ตาราง 2-11  การแกไขปญหาในการติดต้ังฮารดแวร

คอมพิวเตอรไมรับรูอุปกรณใหมวาเปนสวนหน่ึงของระบบ

สาเหตุ วิธีแกไข

ไมไดติดต้ังหรือเช่ือมตออุปกรณอยางเหมาะสม ตรวจสอบวาไดติดตัง้หรือเชื่อมตออุปกรณอยางถูกตองและแนนหนา และ
ขาของชองเสียบไมหักหรืองอ

สายเคเบิลของอุปกรณภายนอกชิ้นใหมไมแนนหรือไมไดเสียบสายไฟ ตรวจสอบวาไดติดตัง้หรือเชื่อมตออุปกรณอยางถูกตองและแนนหนา และ
ขาของชองเสียบไมหักหรืองอ

ไมไดเปดสวิตชเพาเวอรของอุปกรณภายนอก ปดเคร่ืองคอมพิวเตอร เปดอุปกรณภายนอก จากนั้นเปดเคร่ืองคอมพิวเตอร
เพื่อใหอุปกรณใหมรวมอยูในระบบของคอมพิวเตอร

คุณไมไดปฏิบัติตามที่เคร่ืองคอมพิวเตอรแนะนำใหแกไขการตั้งคา บูตระบบใหมและทำตามคำแนะนำเพื่อยอมรับการแกไข

การดแบบพลักแอนดเพลยอาจไมไดรับการตั้งคาโดยอัตโนมัติในขณะที่
เพ่ิมเขาสูระบบ หากการต้ังคาดีฟอลตมีขอขัดแยงกับอุปกรณอื่น

ใชโปรแกรม Windows XP Device Manager เพ่ือยกเลิกการเลือกคา
อัตโนมัติของการด และเลือกการต้ังคาพ้ืนฐานที่ไมทำใหเกิดขอขัดแยง
นอกจากนี้คุณยงัสามารถใชยูทิลิตีการตั้งคาคอมพิวเตอรเพื่อกำหนดคาใหม
หรือตัดการทำงานของอุปกรณเพ่ือแกไขปญหาความขัดแยง

พอรต USB บนคอมพิวเตอรถูกปดการใชงานในโปรแกรมการตั้งคาเครื่อง
คอมพิวเตอร

เขาสูโปรแกรมการตั้งคาคอมพิวเตอร (F10) และเปดใชพอรต USB

คอมพิวเตอรไมทำงาน

สาเหตุ วิธีแกไข

โมดูลหนวยความจำที่ไมถูกตองถูกใชในเวอรชันอัพเกรด หรือโมดูลหนวย
ความจำถูกติดตั้งในตำแหนงท่ีไมถูกตอง

1. โปรดอานเอกสารที่มาพรอมกับเคร่ืองคอมพิวเตอรเพ่ือตรวจวาคุณ
ใชโมดูลหนวยความจำและวิธีการตดิต้ังท่ีถูกตอง

2. สังเกตเสียงและไฟสถานะที่แผงดานหนาของคอมพิวเตอร เสียง
บี๊ปและไฟที่กะพริบหมายถึงรหัสของปญหาเฉพาะ

3. หากคุณยังไมสามารถแกปญหาได โปรดติดตอฝายบริการลูกคา
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ไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 5 ครั้งทุกๆ วินาที จากน้ันเวน 2 วินาที และคอมพิวเตอรสงสัญญาณเสียง 5 คร้ัง (เสียงเตือนจะหยุดหลังจากดังติด
ตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

หนวยความจำเสียหายหรือติดตั้งไมถูกตอง ขอควรระวัง ในการหลีกเล่ียงความเสียหายของ DIMM หรือ
เมนบอรด คุณตองถอดปลั๊กคอมพิวเตอรกอนท่ีจะพยายามตอ ติด
ต้ัง หรือนำโมดูล DIMM ออก

1. ใส DIMM ใหมอีกคร้ัง เปดเคร่ืองคอมพิวเตอร

2. เปลี่ยน DIMM ทีละช้ิน เพื่อแยกโมดูลท่ีมีขอผิดพลาดออก

3. ใชหนวยความจำของ HP แทนหนวยความจำของผูผลิตรายอื่น

4. เปลี่ยนเมนบอรด

ไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 6 ครั้งทุกๆ วินาที จากน้ันเวน 2 วินาที และคอมพิวเตอรสงสัญญาณเสียง 6 คร้ัง (เสียงเตือนจะหยุดหลังจากดังติด
ตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

การดกราฟกเสียหายหรือตอไมถูกตอง หรือเมนบอรดไมถูกตอง สำหรับระบบท่ีใชการดแสดงผล:

1. ติดตั้งการดแสดงผลใหม เปดเคร่ืองคอมพิวเตอร

2. เปลี่ยนการดแสดงผล

3. เปลี่ยนเมนบอรด

สำหรับระบบท่ีใชกราฟกภายใน ใหเปลี่ยนเมนบอรด

ไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 10 ครั้งทุกๆ วินาที จากน้ันเวน 2 วินาที และคอมพิวเตอรสงสัญญาณเสียง 10 คร้ัง (เสียงเตือนจะหยุดหลังจากดัง
ติดตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

การดเสริมมีขอบกพรอง 1. ตรวจสอบการดเสริมแตละอัน โดยถอดการดออกมาทีละอัน (ในกรณี
ท่ีติดตั้งการดหลายอัน) จากน้ันใหเปดเครื่อง เพื่อดูวายังมีขอบกพรอง
หรือไม

2. ถาพบการดท่ีผิดปกติ ใหถอดออกและเปลี่ยนอันใหม

3. เปลี่ยนเมนบอรด

ตาราง 2-11  การแกไขปญหาในการติดต้ังฮารดแวร (ตอ)
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การแกไขปญหาเกี่ยวกับเน็ตเวิรก
ตารางตอไปนี้เปนสาเหตุและการแกไขปญหาเกี่ยวกับเน็ตเวิรกที่พบบอย คำแนะนำเหลาน้ีจะไมกลาวถึงกระบวนการแกไข
ปญหาการวางสายเน็ตเวิรก

ตาราง 2-12  การแกไขปญหาเกี่ยวกับเน็ตเวิรก

คุณสมบัติ Wake-on-LAN ไมทำงาน

สาเหตุ วิธีแกไข

ไมไดเปดใช Wake-on-LAN

หมายเหตุ NIC บางรุนมาพรอมกับแอปเพลตการกำหนดคา
ของตัวเอง ท่ีเปดโอกาสใหมีการควบคุมและการกำหนดคา
คุณสมบัติท่ีมีขอดอยไดอยางละเอียดมากย่ิงข้ึน โปรดดูราย
ละเอียดเพ่ิมเติมในเอกสารคูมือท่ีมาพรอมกับ NIC

เปดใช Wake-on-LAN

1. เลือก Start > Control Panel

2. ดับเบิลคลิก Network Connections

3. ดับเบิลคลิก Local Area Connection

4. คลิก Properties

5. คลิก Configure

6. คลิกแท็บ Power Management แลวเลือกหรือยกเลิกการเลือก
กลองตัวเลือก Allow this device to bring the computer
out of standby

ไดรเวอรของเนต็เวิรกไมพบคอนโทรลเลอรเนต็เวิรก

สาเหตุ วิธีแกไข

ไมไดใชงานคอนโทรลเลอรเน็ตเวิรก 1. รันยูทิลิตีการตั้งคาคอมพิวเตอรและใชงานคอนโทรลเลอรเน็ตเวิรก

2. เปดใชคอนโทรลเลอรเน็ตเวิรกในระบบปฏิบัติการ โดยผาน Device
Manager

ไดรเวอรเน็ตเวิรกไมถูกตอง ตรวจสอบเอกสารของคอนโทรลเลอรของเน็ตเวิรกเพ่ือดูไดรเวอรท่ีถูกตอง
หรือโหลดไดรเวอรลาสุดจากเว็บไซตของผูผลิต

ไฟสถานะการเชื่อมตอเน็ตเวิรกไมกะพริบ

หมายเหตุ ไฟสถานะการเชื่อมตอเน็ตเวิรกจะตองกะพริบเมื่อมีการเชื่อมตอเน็ตเวิรก

สาเหตุ วิธีแกไข

ไมพบเน็ตเวิรกที่ใชงานได ตรวจสอบการวางสายและอุปกรณของเน็ตเวิรกวามีการเชื่อมตอท่ีเหมาะสม

ไมไดต้ังคาคอนโทรลเลอรเน็ตเวิรกอยางถูกตอง ตรวจสอบสถานะของอุปกรณภายใน Windows เชน ตรวจสอบการโหลด
ไดรเวอรใน Device Manager และตรวจสอบสถานะการเชื่อมโยงใน
แอปเพลต Network Connections ภายใน Windows

ไมไดใชงานคอนโทรลเลอรเน็ตเวิรก 1. รันยูทิลิตีการตั้งคาคอมพิวเตอรและใชงานคอนโทรลเลอรเน็ตเวิรก

2. เปดใชคอนโทรลเลอรเน็ตเวิรกในระบบปฏิบัติการ โดยผาน Device
Manager
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ไฟสถานะการเชื่อมตอเน็ตเวิรกไมกะพริบ

หมายเหตุ ไฟสถานะการเชื่อมตอเน็ตเวิรกจะตองกะพริบเมื่อมีการเชื่อมตอเน็ตเวิรก

สาเหตุ วิธีแกไข

ไมไดโหลดไดรเวอรของเน็ตเวิรกอยางถูกตอง ติดต้ังไดรเวอรเน็ตเวิรกใหม โปรดดู คูมือการสื่อสารทางเน็ตเวิรกและ
อินเทอรเน็ต ใน แผนซีด ีDocumentation and Diagnostics

ระบบไมสามารถตรวจจับเน็ตเวิรกโดยอัตโนมัติ เลิกใชคุณสมบัติการตรวจจับอัตโนมัตแิละกำหนดใหระบบเขาสูโหมดการ
ทำงานท่ีถูกตอง โปรดดู คูมือการสื่อสารทางเน็ตเวิรกและอินเทอรเน็ต ใน
แผนซีดี Documentation and Diagnostics

โปรแกรมวินิจฉัยรายงานขอขัดของ

สาเหตุ วิธีแกไข

ตอสายเคเบิลไมแนน ตรวจสอบวาตอสายเคเบิลไวอยางแนนหนากับชองเสียบของเน็ตเวิรก และ
ปลายอีกดานของสายตอกับอุปกรณที่ถูกตอง

สายเคเบิลไมไดตอกับชองเสียบท่ีถูกตอง ตรวจสอบวามีการตอสายเคเบิลกับชองเสียบท่ีถูกตอง

มีปญหาเก่ียวกับสายเคเบิลหรืออุปกรณท่ีปลายอกีดานของสาย ตรวจสอบวาสายเคเบิลและอุปกรณทีป่ลายสายทำงานถูกตอง

คาอินเทอรัปตของคอนโทรลเลอรเน็ตเวิรกถูกใชรวมกับการดเอ็กซแพนชัน
อื่น

ในเมนู Advanced ของยูทิลิตีการต้ังคาคอมพิวเตอร ใหเปล่ียนการต้ังคา
ทรัพยากรของการด

คอนโทรลเลอรเน็ตเวิรกเสีย ติดตอผูใหบริการท่ีไดรับอนุญาต

การวินิจฉัยผาน แตคอมพิวเตอรไมทำงานรวมกับเน็ตเวิรก

สาเหตุ วิธีแกไข

ไมไดโหลดไดรเวอรของเน็ตเวิรก หรือพารามิเตอรของเน็ตเวิรกไมตรงกับ
การตั้งคาปจจุบัน

ตรวจสอบวามีการโหลดไดรเวอรที่ถูกตอง และพารามิเตอรของเน็ตเวิรก
ตรงกับการตั้งคาของระบบ

ตรวจสอบวาไดติดต้ังไคลเอนตและโปรโตคอลของเน็ตเวิรกแลว

คอนโทรลเลอรเน็ตเวิรกไมไดรับการตั้งคาสำหรับคอมพิวเตอรน้ี เลือกไอคอน Network ใน Control Panel และต้ังคาคอนโทร
ลเลอรเน็ตเวิรก

คอนโทรลเลอรเน็ตเวิรกหยุดทำงานเม่ือมีการเพิ่มการดเอ็กซแพนชันในคอมพิวเตอร

สาเหตุ วิธีแกไข

คาอินเทอรัปตของคอนโทรลเลอรเน็ตเวิรกถูกใชรวมกับการดเอ็กซแพนชัน
อื่น

ในเมนู Advanced ของยูทิลิตีการต้ังคาคอมพิวเตอร ใหเปล่ียนการต้ังคา
ทรัพยากรของการด

คอนโทรลเลอรเน็ตเวิรกจำเปนตองใชไดรเวอร ตรวจสอบวาไดรเวอรไมไดถูกลบไปโดยไมไดตั้งใจขณะที่ติดต้ังการดเอ็กซ
แพนชันใหม

การดเอ็กซแพนชันท่ีติดตั้งเปนการดเน็ตเวิรก (NIC) และมีขอขัดแยงกับ
NIC ภายในระบบ

ในเมนู Advanced ของยูทิลิตีการต้ังคาคอมพิวเตอร ใหเปล่ียนการต้ังคา
ทรัพยากรของการด

ตาราง 2-12  การแกไขปญหาเกี่ยวกับเน็ตเวิรก (ตอ)
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คอนโทรลเลอรเน็ตเวิรกหยุดทำงานโดยไมมีสาเหตุแนชัด

สาเหตุ วิธีแกไข

ไฟลท่ีบรรจุไดรเวอรของเน็ตเวิรกเสียหาย ดาวนโหลดไดรเวอรของเน็ตเวิรก http://www.hp.com และติดต้ังใหมอีก
ครั้ง

ตอสายเคเบิลไมแนน ตรวจสอบวาตอสายเคเบิลไวอยางแนนหนากบัชองเสียบของเน็ตเวิรก และ
ปลายอีกดานของสายตอกับอุปกรณที่ถูกตอง

คอนโทรลเลอรเน็ตเวิรกเสีย ติดตอผูใหบริการท่ีไดรับอนุญาต

ไมสามารถบูตดวยการดเน็ตเวิรกใหม

สาเหตุ วิธีแกไข

การดเน็ตเวิรกใหมอาจมีขอบกพรอง หรือไมเปนไปตามมาตรฐาน ติดต้ัง NIC แบบมาตรฐานที่สามารถใชการได หรือเปล่ียนลำดับการบูตเพื่อ
เร่ิมตนระบบโดยใชอุปกรณอื่น

ไมสามารถเชื่อมตอกับเซิรฟเวอรของเนต็เวิรกขณะพยายามใชการติดต้ังระบบจากเครื่องอื่น

สาเหตุ วิธีแกไข

ไมไดต้ังคาคอนโทรลเลอรเน็ตเวิรกไวอยางถูกตอง ตรวจสอบการเชื่อมตอเน็ตเวิรก เพื่อดูวามีเซิรฟเวอร DHCP อยูหรือไม
และเซิรฟเวอรการติดตั้งระบบจากเครื่องอื่นมีไดรเวอร NIC สำหรับ NIC
ของคุณ

ยูทิลิตีการตั้งคาระบบรายงาน EEPROM ท่ีไมไดโปรแกรม

สาเหตุ วิธีแกไข

EEPROM ที่ไมไดโปรแกรม ติดตอผูใหบริการท่ีไดรับอนุญาต

ตาราง 2-12  การแกไขปญหาเกี่ยวกับเน็ตเวิรก (ตอ)
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การแกไขปญหาเกี่ยวกับหนวยความจำ
หากคุณพบปญหาเกี่ยวกับหนวยความจำ โปรดอานสาเหตุและการแกไขปญหาที่พบบอยในตารางตอไปนี้

ขอควรระวัง อาจมีการปอนกำลังไฟใหกับ DIMM อยูตอไปเม่ือปดคอมพิวเตอรแลว ในการหลีกเล่ียงความเสียหาย
ของ DIMM หรือเมนบอรด คุณตองถอดปลั๊กคอมพิวเตอรกอนที่จะพยายามตอ ติดตั้ง หรือนำโมดูล DIMM ออก

สำหรับระบบที่สามารถใชหนวยความจำ ECC นั้น HP จะไมรองรับการใชหนวยความจำแบบ ECC และไมใช
ECC รวมกัน มิฉะนั้น คอมพิวเตอรจะไมบูตระบบปฏิบัติการ

ตาราง 2-13  การแกไขปญหาเกี่ยวกับหนวยความจำ

ระบบไมบูตหรือทำงานไมถูกตองหลังจากติดต้ังหนวยความจำเพิ่มเตมิ

สาเหตุ วิธีแกไข

โมดูลหนวยความจำเปนประเภท หรือระดับความเร็วท่ีไมถูกตองสำหรับ
ระบบ หรือติดต้ังหนวยความจำไมถูกตอง

เปลี่ยนไปใชอุปกรณมาตรฐานสำหรับระบบของคุณ ในคอมพิวเตอรบางรุน
หนวยความจำ ECC และท่ีไมใช ECC จะไมสามารถทำงานรวมกัน

เกิดขอผิดพลาดเน่ืองจากหนวยความจำไมเพียงพอ

สาเหตุ วิธีแกไข

การกำหนดหนวยความจำอาจไมถูกตอง ใชโปรแกรม Device Manager เพ่ือตรวจสอบการกำหนดหนวยความจำ

มีหนวยความจำไมเพียงพอท่ีจะรันแอปพลิเคชัน ตรวจสอบเอกสารที่มาพรอมกับแอปพลิเคชันเพื่อดูขอกำหนดเก่ียวกบั
หนวยความจำ

การนับหนวยความจำระหวางกระบวนการ POST ไมถูกตอง

สาเหตุ วิธีแกไข

อาจติดต้ังโมดูลหนวยความจำไมถูกตอง ตรวจสอบวาหนวยความจำทั้งหมดถูกติดต้ังอยางถูกตองและใชโมดลูท่ีถูก
ตอง

กราฟกภายในอาจใชหนวยความจำระบบ ไมตองดำเนินการใดๆ

เกิดขอผิดพลาดเนื่องจากหนวยความจำไมเพียงพอขณะทำงาน

สาเหตุ วิธีแกไข

มีโปรแกรมประเภท TSR ติดตั้งอยูมากเกินไป ลบโปรแกรม TSR ท่ีไมตองการใชออก

มีหนวยความจำไมเพียงพอท่ีจะรันแอปพลิเคชัน ตรวจสอบความตองการหนวยความจำของแอปพลิเคชัน หรือเพ่ิมหนวย
ความจำใหกับระบบ

ไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 5 ครั้งทุกๆ วินาที จากน้ันเวน 2 วินาที และคอมพิวเตอรสงสัญญาณเสียง 5 คร้ัง (เสียงเตือนจะหยุดหลังจากดังติด
ตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

หนวยความจำเสียหายหรือติดตั้งไมถูกตอง 1. ใส DIMM ใหมอีกคร้ัง เปดเคร่ืองคอมพิวเตอร

2. เปลี่ยน DIMM ทีละช้ิน เพื่อแยกโมดูลท่ีมีขอผิดพลาดออก
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ไฟสถานะเปดเคร่ืองกะพริบเปนสีแดง 5 คร้ังทุกๆ วินาที จากน้ันเวน 2 วินาที และคอมพิวเตอรสงสัญญาณเสียง 5 คร้ัง (เสียงเตือนจะหยุดหลังจากดังติด
ตอกันเปนคร้ังท่ี 5 แตไฟ LED จะกะพริบตอไป)

สาเหตุ วิธีแกไข

3. ใชหนวยความจำของ HP แทนหนวยความจำของผูผลิตรายอื่น

4. เปล่ียนเมนบอรด

ตาราง 2-13  การแกไขปญหาเกี่ยวกับหนวยความจำ (ตอ)
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การแกไขปญหาเกี่ยวกับโปรเซสเซอร
หากคุณพบปญหาเกี่ยวกับโปรเซสเซอร โปรดอานสาเหตุและการแกไขปญหาที่พบบอยในตารางตอไปน้ี

ตาราง 2-14  การแกไขปญหาเกี่ยวกับโปรเซสเซอร

มีการทำงานอยางไมเต็มประสิทธิภาพ

สาเหตุ วิธีแกไข

โปรเซสเซอรมีอุณหภูมิสูง 1. ตรวจสอบวาชองระบายอากาศถกูปดก้ันหรือไม

2. ตรวจดวูาพัดลมถูกเชื่อมตอและทำงานอยางถูกตอง (พัดลมบางตัวทำ
งานเมื่อจำเปนเทานั้น)

3. ตรวจสอบวาตัวระบายความรอนของโปรเซสเซอรถูกติดต้ังอยางถูก
ตอง

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 3 คร้ังทุกๆ วินาที จากนั้นเวน 2 วินาที

สาเหตุ วิธีแกไข

ไมไดตอหรอืติดต้ังโปรเซสเซอรอยางถูกตอง 1. ตรวจดวูามีโปรเซสเซอรอยูในเครื่องหรือไม

2. ติดต้ังโปรเซสเซอรอีกคร้ัง
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การแกไขปญหาซีดีรอมและดีวีดี
หากคุณพบปญหาเกี่ยวกับซีดีรอมและดีวีดี โปรดดูสาเหตุและวิธีแกไขปญหาที่พบบอยในตารางตอไปนี้ และในเอกสารที่มา
พรอมกับอุปกรณเสริมดังกลาว

ตาราง 2-15  การแกไขปญหาซีดีรอมและดีวีดี

ระบบไมบูตจากไดรฟซีดีรอมหรือดีวีดี

สาเหตุ วิธีแกไข

อุปกรณติดต้ังลงในพอรต SATA ท่ีไมถูกเปดใชงานในยูทิลิตีการต้ังคา
คอมพิวเตอร

รันยูทิลิตีการตั้งคาคอมพิวเตอร และโปรดตรวจสอบใหแนใจวาพอรตของ
อุปกรณ SATA เปดใชงานใน Storage > Storage Options

ระบบการปฏิบัติการรุนเกาไมสนับสนุนอุปกรณบูตท่ีตอเขากับพอรต
SATA 4 หรือพอรต SATA

เช่ือมตออุปกรณบูตเขากับพอรต SATA 0 หรือพอรต SATA 1

Removable Media Boot ถูกยกเลิกการใชงานในยูทิลิตีการตั้งคา
คอมพิวเตอร

รันยูทิลิตีการตั้งคาคอมพิวเตอร และเปดใชการบูตไปยังสื่อท่ีถอดออกไดใน
Storage > Storage Options ตรวจสอบวาไดเปดใชซีดีรอมใน
Storage > Boot Order

Network Server Mode ถูกยกเลิกการใชงานในยูทิลิตีการต้ังคา
คอมพิวเตอร

รันยูทิลิตีการตั้งคาคอมพิวเตอร และยกเลิกการใช Network Server
Mode ใน Security > Password Options

มีแผนซีดีท่ีบูตไมไดอยูในไดรฟ ลองใชแผนซีดีท่ีบูตได

ลำดับการบูตไมถูกตอง รันยูทิลิตีการตั้งคาคอมพิวเตอร แลวเปล่ียนลำดับการบูตใน Storage >
Boot Order

ไมพบไดรฟ (ท่ีระบุ)

สาเหตุ วิธีแกไข

สายเคเบิลอาจหลวม ตรวจสอบการตอสายเคเบิล

ระบบอาจไมรับทราบถึงไดรฟท่ีติดตั้งขึ้นใหมไดโดยอัตโนมัติ โปรดดูคำแนะนำในการตั้งคาใหมในหัวขอ การแกไขปญหาในการติดต้ัง
ฮารดแวร หากระบบยังไมรับรูถึงอุปกรณใหม ใหตรวจสอบวามีอุปกรณน้ัน
แสดงอยูภายในยูทิลิตีการต้ังคาคอมพิวเตอรหรือไม หากมีอยู สาเหตุของ
ปญหาอาจอยูท่ีไดรเวอร แตหากไมมีอุปกรณดังกลาวอยู ปญหาน้ีอาจเกิด
จากฮารดแวร

หากไดรฟนั้นเปนไดรฟท่ีติดตั้งใหม ใหรันยูทิลิตีการตั้งคาคอมพิวเตอร
และลองเพิ่มระยะเวลาการรอในกระบวนการ POST ท่ี Advanced >
Power-On Options

อุปกรณติดต้ังลงในพอรต SATA ท่ีไมถูกเปดใชงานในยูทิลิตีการต้ังคา
คอมพิวเตอร

รันยูทิลิตีการตั้งคาคอมพิวเตอร และโปรดตรวจสอบใหแนใจวาพอรตของ
อุปกรณ SATA เปดใชงานใน Storage > Storage Options

ไดรฟตอบสนองชาหลังจากการเริ่มตนระบบ รันยูทิลิตีการตั้งคาคอมพิวเตอร และเพิ่มเวลารอของกระบวนการ POST
ใน Advanced > Power-On Options

ไมพบหรือไมไดโหลดไดรเวอรของอุปกรณซีดีรอมหรือดีวีดี

สาเหตุ วิธีแกไข

ไมไดตอหรือต้ังคาไดรฟไวอยางเหมาะสม โปรดดูเอกสารที่มาพรอมกับอุปกรณเสริม
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ไมสามารถเปดภาพยนตจากไดรฟดีวีดี

สาเหตุ วิธีแกไข

ภาพยนตนั้นอาจถูกกำหนดพ้ืนท่ีไวสำหรับประเทศ/พื้นท่ีอื่น โปรดดูเอกสารที่มาพรอมกับไดรฟดีวีดี

ไมไดติดต้ังซอฟตแวรแปลงสัญญาณ ติดตั้งซอฟตแวรแปลงสัญญาณ

สื่อไดรับความเสียหาย เปลี่ยนสื่อ

มีการล็อคเรตติ้งภาพยนตร ใชซอฟตแวรดีวีดีเพ่ือยกเลิกการล็อค

ใสสื่อในลักษณะกลับหัว ใสสื่อใหมอีกคร้ัง

นำดิสกออกจากไดรฟไมได (ไดรฟแบบถาด)

สาเหตุ วิธีแกไข

ใสแผนดิสกในไดรฟไมถูกตอง ปดระบบคอมพิวเตอรและสอดลวดโลหะเล็กๆ ในชองนำดิสกออกฉุกเฉิน
และดันเขา คอยๆ ดึงถาดออกจากไดรฟจนกระท่ังสุด จากน้ันนำดิสกออกมา

ไดรฟ CD-ROM, CD-RW, DVD-ROM หรือ DVD-R/RW ไมสามารถอานดิสกหรือใชเวลาในการเริ่มทำงานนานเกินไป

สาเหตุ วิธีแกไข

ใสสื่อผิดดาน ใสสื่อใหมโดยใหดานฉลากอยูดานบน

ไดรฟ DVD-ROM ใชเวลานานในการเริ่มตนเพราะตองกำหนดชนิดของ
สื่อ เชน เสียงหรือภาพ

รอเปนเวลาอยางนอย 30 วินาทีเพื่อใหไดรฟ DVD-ROM กำหนดชนิดของ
สื่อท่ีเลน หากดิสกยังไมเร่ิมทำงาน อานวิธีแกไขอื่นๆ ท่ีอยูในหัวขอนี้

แผนซีดีหรือดีวีดีสกปรก ทำความสะอาดซีดีหรือดีวดีีดวยชุดทำความสะอาดซีดี ท่ีมีขายในราน
คอมพิวเตอรสวนใหญ

Windows ไมพบไดรฟ CD-ROM หรือ DVD-ROM 1. ใช Device Manager เพื่อถอดหรือถอนการติดตั้งอุปกรณดังกลาว

2. รีสตารทคอมพิวเตอรของคุณใหมและให Windows คนหาไดรฟซีดี
และดีวีดี

การบันทึกหรือการคัดลอกซีดีมีปญหาหรือไมสามารถทำได

สาเหตุ วิธีแกไข

ชนิดของสื่อไมถูกตองหรือมีคุณภาพไมดี 1. ลองใชความเรว็ท่ีชาลงเมื่อทำการบันทึก

2. ตรวจสอบวาคณุใชสื่อท่ีถูกตองสำหรับไดรฟ

3. ลองใชสื่อย่ีหออ่ืน คุณภาพจะแตกตางกันไปตามผูผลิต

คอมพิวเตอร USDT บูตชามากหลังจากถอดไดรฟ CD-ROM หรือ DVD

สาเหตุ วิธีแกไข

ระบบกำลงัคนหาไดรฟในขณะท่ีบูตเน่ืองจากสายเคเบิลไดรฟยังตอเขากับ
เมนบอรด

ถอดสายเคเบิลไดรฟออกจากเมนบอรด

ตาราง 2-15  การแกไขปญหาซีดีรอมและดีวีดี (ตอ)
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การแกไขปญหาเกี่ยวกับ Drive Key
หากคุณพบปญหาเกี่ยวกับ Drive Key โปรดดูสาเหตุและวิธีแกไขปญหาที่พบบอยในตารางตอไปนี้

ตาราง 2-16  การแกไขปญหาเกี่ยวกับ Drive Key

Drive Key ของ USB ไมปรากฏเปนตัวอักษรชื่อไดรฟใน Windows XP

สาเหตุ วิธีแกไข

ไมมีตัวอักษรชื่อไดรฟตอจากไดรฟทางกายภาพตัวสุดทาย เปลี่ยนตัวอักษรช่ือไดรฟท่ีเปนคาดีฟอลตสำหรับ Drive Key ใน
Windows XP

ไมพบ Drive Key ของ USB (ท่ีระบุไว)

สาเหตุ วิธีแกไข

อุปกรณติดต้ังลงในพอรต USB ท่ีถูกซอนไวในยูทิลิตีการต้ังคา
คอมพิวเตอร

รันยูทิลิตีการตั้งคาคอมพิวเตอรและดูใหแนใจวาไดเลือก "Device
available" สำหรับ "All USB Ports" และ "Front USB Ports" ใต
Security > Device Security แลว

อุปกรณยังไมแนนกอนเปดเครื่อง ดูใหแนใจวาไดยึดอุปกรณลงในพอรต USB ไดอยางแนนหนาแลวกอน
เปดเคร่ือง

ระบบจะไมบูตจาก Drive Key ของ USB

สาเหตุ วิธีแกไข

ลำดับการบูตไมถูกตอง รันยูทิลิตีการตั้งคาคอมพิวเตอร แลวเปล่ียนลำดับการบูตใน Storage >
Boot Order

Removable Media Boot ถูกยกเลิกการใชงานในยูทิลิตีการตั้งคา
คอมพิวเตอร

รันยูทิลิตีการตั้งคาคอมพิวเตอร และเปดใชการบูตไปยังสื่อท่ีถอดออกไดใน
Storage > Storage Options ตรวจสอบวา ไดเปดใช USB ใน
Storage > Boot Order

ไมสามารถบูตภาพบนอุปกรณ ปฏิบัติตามขั้นตอนท่ีอธิบายไวใน “การแฟลช ROM: การจำลองการตั้งคา:
การสรางอุปกรณท่ีใชบูต: อุปกรณสื่อสำหรับการแฟลชทาง USB ท่ีรองรับ”
ของ Service Reference Guide

คอมพิวเตอรจะบูตไปที ่DOS หลังจากท่ีทำ Drive Key ท่ีสามารถใชบูตได

สาเหตุ วิธีแกไข

Drive Key สามารถใชบูตได ติดต้ัง Drive Key หลังจากท่ีบูตระบบปฏิบัติการแลวเทาน้ัน
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การแกไขปญหาสวนประกอบแผงดานหนา
หากคุณพบปญหาเกี่ยวกับอุปกรณที่เช่ือมตอกับแผงดานหนา โปรดดูสาเหตุและการแกไขปญหาที่พบบอยในตารางตอไปนี้

ตาราง 2-17  การแกไขปญหาสวนประกอบแผงดานหนา

คอมพิวเตอรไมรับรูการเชื่อมตออุปกรณ USB, หูฟง หรือไมโครโฟน

สาเหตุ วิธีแกไข

ไมไดเช่ือมตออุปกรณอยางเหมาะสม 1. ปดเคร่ืองคอมพิวเตอร

2. เชื่อมตออุปกรณอีกคร้ังท่ีดานหนาของคอมพิวเตอรและเริ่มตนการ
ทำงานของคอมพิวเตอรใหม

อุปกรณไมไดรับกระแสไฟ หากอุปกรณ USB ตองใชไฟฟา AC โปรดแนใจวาปลายดานหนึ่งเช่ือมตอ
กับอุปกรณแลว และปลายอีกดานเชื่อมตอกับเตารับไฟฟาที่มีไฟฟา

ไมไดติดต้ังไดรเวอรท่ีถูกตองของอุปกรณ 1. ติดตั้งไดรเวอรในเวอรชันที่ถูกตองสำหรับอุปกรณ

2. คุณอาจจะตองรีบูตคอมพิวเตอร

สายเคเบิลจากอุปกรณท่ีตอกับคอมพิวเตอรใชงานไมได 1. หากเปนไปได ใหเปล่ียนสายเคเบิล

2. เริ่มการทำงานของคอมพิวเตอรใหม

อุปกรณไมทำงาน 1. เปลี่ยนอุปกรณ

2. เริ่มการทำงานของคอมพิวเตอรใหม

พอรต USB บนคอมพิวเตอรถูกปดการใชงานในโปรแกรมการตั้งคาเคร่ือง
คอมพิวเตอร

เขาสูโปรแกรมการตั้งคาคอมพิวเตอร (F10) และเปดใชพอรต USB
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การแกไขปญหาในการเชื่อมตออินเทอรเน็ต
หากคุณพบปญหาในการเช่ือมตออินเทอรเน็ต โปรดติดตอผูใหบริการอินเทอรเน็ต (ISP) หรือดูสาเหตุและวิธีแกไขปญหาที่
พบบอยในตารางตอไปนี้

ตาราง 2-18  การแกไขปญหาในการเชื่อมตออินเทอรเน็ต

ไมสามารถเชื่อมตออินเทอรเน็ต

สาเหตุ วิธีแกไข

ไมไดต้ังคาบัญชีอินเทอรเน็ตอยางถูกตอง ตรวจสอบการตั้งคาอินเทอรเน็ต หรือติดตอขอความชวยเหลือจาก ISP

ต้ังคาโมเด็มไมถูกตอง ตอโมเด็มใหมอีกครั้ง ตรวจสอบวาการเช่ือมตอถูกตองหรือไม โดยดูจาก
เอกสารการติดต้ังอยางรวดเร็ว

ไมไดติดต้ังเว็บเบราเซอรอยางถูกตอง ตรวจดูวาเว็บเบราเซอรไดรับการติดต้ังและต้ังคาใหสามารถทำงานกับ ISP
ของคุณ

ไมไดเสียบปล๊ักโมเด็มสำหรับเคเบิล/DSL เสียบปล๊ักโมเด็มสำหรับเคเบิล/DSL ไฟสถานะ “power” ท่ีดานหนาของ
โมเด็มสำหรับเคเบิล/DSL ควรจะติด

บริการเคเบิล/DSL ไมพรอมใชงานหรือขัดของเน่ืองจากสภาพอากาศไมดี ลองเชื่อมตออินเทอรเน็ตในภายหลัง หรือติดตอ ISP ของคุณ (หากมีการ
เช่ือมตอบริการเคเบิล/DSL ไฟสถานะ “cable” ท่ีดานหนาของโมเด็ม
สำหรับเคเบิล/DSL ควรจะติด)

ไมไดเช่ือมตอสายเคเบิล CAT5 UTP เช่ือมตอสายเคเบิล CAT5 ระหวางเคเบิลโมเด็มกับชองเสียบ RJ-45 ของ
คอมพิวเตอร (หากการเช่ือมตอเปนปกติ ไฟสถานะ “PC” ท่ีดานหนาของ
โมเด็มสำหรับเคเบิล/DSL จะติด)

กำหนดแอดเดรส IP ไมถูกตอง ติดตอ ISP ของคุณเพ่ือสอบถามแอดเดรส IP ท่ีถูกตอง

คุกก้ีไดรับความเสียหาย (“คุกกี้” คือขอมูลขนาดเล็กท่ีเว็บเซิรฟเวอรสามารถ
จัดเก็บชั่วคราวไวพรอมกับเว็บเบราเซอรของคณุ เพ่ือใหเบราเซอรของคุณ
จดจำขอมูลเฉพาะบางอยางซึ่งเว็บเซิรฟเวอรจะสามารถเรียกดูในภายหลัง)

Windows XP

1. เลือก Start > Control Panel

2. ดับเบิลคลิก Internet Options

3. บนแท็บ General ใหคลิกท่ีปุม Delete Cookies

Windows 2000

1. เลือก Start > Settings > Control Panel

2. ดับเบิลคลิก Internet Options

3. บนแท็บ General ใหคลิกท่ีปุม Delete Cookies

ไมสามารถเปดโปรแกรมอินเทอรเน็ตโดยอัตโนมัติ

สาเหตุ วิธีแกไข

คุณจะตองล็อกออนเขาสูระบบของ ISP เสียกอน บางโปรแกรมจึงจะ
สามารถเริ่มตนการทำงานได

ล็อกออนเขาสูระบบของ ISP แลวเปดโปรแกรมที่ตองการ

ใชเวลานานเกินไปในการดาวนโหลดเว็บไซต

สาเหตุ วิธีแกไข

ต้ังคาโมเด็มไมถูกตอง ตรวจสอบวาความเร็วของโมเด็มและพอรต COM ท่ีเลือกถูกตองหรือไม
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ใชเวลานานเกินไปในการดาวนโหลดเว็บไซต

สาเหตุ วิธีแกไข

Windows XP

1. เลือก Start > Control Panel

2. ดับเบิลคลิก System

3. คลิกแท็บ Hardware

4. ในสวนของ Device Manager ใหคลิกปุม Device Manager

5. ดับเบิลคลิกท่ี Ports (COM & LPT)

6. คลิกขวาท่ีพอรต COM ท่ีตอกับโมเด็มของคุณ แลวคลิก
Properties

7. ในหัวขอ Device status ใหตรวจดูวาโมเด็มทำงานเปนปกติ

8. ในหัวขอ Device usage ใหตรวจดูวาโมเด็มไดถูกเปดใชงานแลว

9. หากมีปญหาอีก ใหคลิกปุม Troubleshoot และปฏิบัติตามคำแนะ
นำบนหนาจอ

Windows 2000

1. เลือก Start > Settings > Control Panel

2. ดับเบิลคลิก System

3. คลิกแท็บ Hardware

4. ในหัวขอ Device Manager ใหคลิกปุม Device Manager

5. ดับเบิลคลิกท่ี Ports (COM & LPT)

6. คลิกขวาท่ีพอรต COM ท่ีตอกับโมเด็มของคุณ แลวคลิก
Properties

7. ในหัวขอ Device status ใหตรวจดูวาโมเด็มทำงานเปนปกติ

8. ในหัวขอ Device usage ใหตรวจดูวาโมเด็มไดถูกเปดใชงานแลว

9. หากมีปญหาอีก ใหคลิกปุม Troubleshoot และปฏิบัติตามคำแนะ
นำบนหนาจอ

ตาราง 2-18  การแกไขปญหาในการเชื่อมตออินเทอรเน็ต (ตอ)
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การแกไขปญหาเกี่ยวกับซอฟตแวร
ปญหาเกี่ยวกับซอฟตแวรสวนใหญเกิดจากสาเหตุตอไปนี:้

● ไมไดติดตั้งหรือตั้งคาแอปพลิเคชันอยางเหมาะสม

● หนวยความจำไมเพียงพอที่จะรันแอปพลิเคชัน

● มีขอขัดแยงระหวางแอปพลิเคชัน

● ตรวจสอบใหแนใจวา ไดติดต้ังไดรเวอรอุปกรณทั้งหมดที่จำเปนแลว

● หากคุณไดติดตั้งระบบปฏิบัติการอื่นที่ไมใชระบบที่ติดตั้งมาจากโรงงาน โปรดตรวจสอบวาระบบนั้นสามารถทำงานได
ในเคร่ืองคอมพิวเตอรของคุณ

หมายเหตุ HP Backup and Recovery Manager สามารถนำมาใชในการคืนคาซอฟตแวรไปไวที่จุดการกูคืน
หรือเพ่ือคืนคาระบบกลับเปนคาที่กำหนดมาจากโรงงาน โปรดดูรายละเอียดเพ่ิมเติมใน การกูคืนซอฟตแวร

หากคุณพบปญหาเกี่ยวกับซอฟตแวร โปรดดูวิธีแกไขปญหาในตารางตอไปนี้

ตาราง 2-19  การแกไขปญหาเกี่ยวกับซอฟตแวร

คอมพิวเตอรไมทำงานตอ และหนาจอโลโก HP ไมปรากฏขึ้น

สาเหตุ วิธีแกไข

เกิดขอผิดพลาด POST สังเกตเสียงและไฟสถานะที่แผงดานหนาของคอมพิวเตอร ดูที่ภาคผนวก
A ขอความแสดงขอผิดพลาดของ POST เพ่ือระบุสาเหตุท่ีเปนไปได

โปรดดู Restore Kit หรือขอกำหนดและเงื่อนไขสำหรับการรับประกัน
แบบจำกัดท่ัวโลก

คอมพิวเตอรไมทำงานตอ หลังจากที่หนาจอโลโก HP ปรากฏขึ้น

สาเหตุ วิธีแกไข

ไฟลระบบอาจเสียหาย เรียกคืนไฟลจาก Recovery Disc Set หรือจากท่ีคุณไดสรางการสำรอง
ขอมูลไวใน HP Backup and Recovery Manager

ขอความแสดงขอผิดพลาด “Illegal Operation has Occurred” ปรากฏข้ึน

สาเหตุ วิธีแกไข

ซอฟตแวรท่ีใชไมไดรับการรับรองจาก Microsoft สำหรับเวอรชัน
Windows ของคุณ

ตรวจสอบวาซอฟตแวรไดรับการรับรองจาก Microsoft สำหรับเวอรชัน
Windows ของคุณ (โปรดดูขอมูลนี้บนหีบหอของโปรแกรม)

ไฟลต้ังคาเสียหาย หากเปนไปได บันทึกขอมูลทั้งหมด ปดโปรแกรมทั้งหมด และรีสตารท
คอมพิวเตอรของคุณ
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การติดตอฝายบริการลูกคา
โปรดติดตอผูขายหรือตัวแทนจำหนายที่ไดรับอนุญาต สำหรับคำแนะนำและบริการ คุณสามารถคนหาผูขายหรือตัวแทน
จำหนายใกลบานคุณไดที่ http://www.hp.com

หมายเหตุ หากคุณนำเคร่ืองคอมพิวเตอรไปรับขอบริการซอมจากผูขาย ตัวแทนจำหนาย หรือผูใหบริการที่ไดรับ
อนุญาต คุณจะตองแจงรหัสผานสำหรับการต้ังคา และรหัสผานเมื่อเปดเคร่ือง ในกรณีที่คุณต้ังรหัสผานไว

ติดตอไปยังหมายเลขโทรศัพทที่แจงไวในใบรับประกัน หรือในคูมือ หมายเลขโทรศัพทฝายสนับสนุน ที่อยูใน แผน
ซีด ีDocumentation and Diagnostics เพื่อขอความชวยเหลือดานเทคนิค

46 บท 2   การแกไขปญหาโดยไมผานโปรแกรมวินิจฉัย THWW

http://www.hp.com


A ขอความแสดงขอผิดพลาดของ POST

ภาคผนวกนี้จะแสดงรหัสขอผิดพลาด ขอผิดพลาด ไฟแสดง และสัญญาณเสียงตางๆ ท่ีคุณอาจพบระหวางที่เคร่ืองทำการทด
สอบโดยอัตโนมัติเมื่อเปดเคร่ือง (Power-On Self Test - POST) หรือเมื่อเร่ิมการทำงานใหม พรอมทั้งสาเหตุที่เปนไปได
ของปญหา และขั้นตอนในการแกปญหา

ตัวเลือก POST Message Disabled จะตัดขอความสวนใหญของระบบในระหวางกระบวนการ POST เชน การนับหนวย
ความจำและขอความที่ไมใชขอผิดพลาด หากมีขอผิดพลาด POST หนาจอจะแสดงขอความแสดงขอผิดพลาด ในการเปด
โหมด POST Messages Enabled เพ่ือขอความระหวาง POST ใหกดปุมใดๆ (ยกเวน F10 หรือ F12) และโหมดที่เปน
ดีฟอลตคือ POST Message Disabled

ความเร็วที่เคร่ืองคอมพิวเตอรโหลดระบบปฏิบัติการและระดับการทดสอบจะขึ้นอยูกบัการเลือกโหมด POST

Quick Boot เปนกระบวนการเริ่มตนแบบรวดเร็วซึ่งไมรันการทดสอบในระดับของระบบทั้งหมด เชน การทดสอบหนวย
ความจำ Full Boot จะรันการทดสอบระบบที่อาศัย ROM ทั้งหมดและใชเวลาในการทดสอบนานกวา

คุณยังสามารถกำหนดตารางการทำ Full Boot เปนประจำทุกๆ 1 ถึง 30 วันไดดวย ในการกำหนดตารางดังกลาว ใหตั้งคาใน
ระบบคอมพิวเตอรไปเปนโหมด Full Boot Every x Days โดยใชยูทิลิตีการตั้งคาคอมพิวเตอร

หมายเหตุ สำหรับขอมูลเพ่ิมเติมเกี่ยวกับการใชยูทิลิตีการตั้งคาคอมพิวเตอร โปรดดูที่ คูมือยูทิลิตีการตั้งคา
คอมพิวเตอร (F10) ใน แผนซีดี Documentation and Diagnostics
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รหัสตัวเลขและขอความ POST
หัวขอน้ีกลาวถึงขอผิดพลาดในกระบวนการ POST ซ่ึงมีรหัสตัวเลขที่เกี่ยวของ รวมถึงขอความที่อาจพบในระหวางกระบวน
การ POST

หมายเหตุ เคร่ืองคอมพิวเตอรจะสงสัญญาณเสียง 1 ครั้ง หลังจากที่ปรากฏขอความ POST บนหนาจอ

ตาราง A-1  รหัสตัวเลขและขอความ

ขอความท่ีแผงควบคุม คำอธิบาย วิธีปฏิบัติท่ีแนะนำ

101-Option ROM Checksum Error การตรวจสอบผลรวม ROM ของระบบ หรือ ROM
เสริมของการดเอ็กซแพนชัน

1. ตรวจสอบวา ROM ถูกตอง

2. แฟลช ROM หากจำเปน

3. ถาเพ่ิงมีการเพิ่มการดเอ็กซแพนชัน ใหถอดออก
และดูวาปญหายังคงอยูหรือไม

4. ลบคาใน CMOS (โปรดดูภาคผนวก B การ
รักษาความปลอดภยัดวยรหัสผานและการรีเซ็ต
CMOS)

5. หากขอความหายไป แสดงวาการดเอ็กซแพน
ชันมีปญหา

6. เปลี่ยนเมนบอรด

103-System Board Failure DMA หรือไทเมอร 1. ลบคาใน CMOS (โปรดดูภาคผนวก B การ
รักษาความปลอดภยัดวยรหัสผานและการรีเซ็ต
CMOS)

2. ถอดการดเอ็กซแพนชัน

3. เปลี่ยนเมนบอรด

110-Out of Memory Space for Option ROMs การดเอ็กซแพนชันท่ีเพ่ิงติดต้ังม ีROM เสริมขนาด
ใหญซึ่งจะตองดาวนโหลดในระหวาง POST

1. ถาเพ่ิงมีการเพิ่มการดเอ็กซแพนชัน PCI ให
ถอดออกและดูวาปญหายังคงอยูหรือไม

2. ในยูทิลิตีการตั้งคาคอมพิวเตอร ใหต้ัง
Advanced > Device Options > NIC
PXE Option ROM Download เปน
DISABLE เพื่อปองกันไมให PXE option
ROM สำหรับ NIC ภายใน ถูกดาวนโหลดใน
ระหวาง POST เพื่อเพ่ิมหนวยความจำสำหรับ
ROM เสริมของการดเอ็กซแพนชัน PXE
option ROM ภายในใชสำหรับการบูตจาก
NIC ไปยังเซิรฟเวอร PXE

3. ดูใหแนใจวาเปดใชการต้ังคา ACPI/USB
Buffers @ Top of Memory ในยูทิลิตีการต้ัง
คาคอมพิวเตอรแลว

162-System Options Not Set การตั้งคาไมถูกตอง

คุณอาจตองเปลี่ยนแบตเตอรี่ของนาฬิกาภายในระบบ
(RTC - real-time clock)

รันยูทิลิตีการต้ังคาคอมพิวเตอร แลวตรวจสอบการ
กำหนดคาใน Advanced > Onboard Devices

ตั้งวันท่ีและเวลาใหมใต Control Panel หากปญหา
ยังคงอยู ใหเปล่ียนแบตเตอรี่ RTC โปรดดู คูมืออางอิง
ฮารดแวร ใน แผนซีดี Documentation and
Diagnostics เพื่อดูคำแนะนำเก่ียวกับการติดตั้ง
แบตเตอรี่ใหม หรือติดตอตัวแทนจำหนายหรือผูขายที่
ไดรับอนุญาตเพ่ือขอคำแนะนำในการเปลี่ยน
แบตเตอรี่ RTC
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ขอความท่ีแผงควบคุม คำอธิบาย วิธีปฏิบัติท่ีแนะนำ

163-Time & Date Not Set เวลาหรือวันท่ีในหนวยความจำการตั้งคาไมถูกตอง

คุณอาจตองเปลี่ยนแบตเตอรี่ของนาฬิกาภายในระบบ
(RTC - real-time clock)

ตั้งเวลาและวันท่ีใหมท่ี Control Panel (หรืออาจใช
ยูทิลิตีการตั้งคาคอมพิวเตอร) หากปญหายังคงอยู ให
เปลี่ยนแบตเตอรี ่RTC โปรดดู คูมอือางอิงฮารดแวร
ใน แผนซีด ีDocumentation and Diagnostics
เพื่อดูคำแนะนำเกี่ยวกับการติดตั้งแบตเตอร่ีใหม หรือ
ติดตอตัวแทนจำหนายหรือผูขายท่ีไดรับอนุญาตเพื่อ
ขอคำแนะนำในการเปลี่ยนแบตเตอรี่ RTC

163-Time & Date Not Set คุณอาจติดต้ังจัมเปอรของ CMOS ไมถูกตอง ตรวจสอบตำแหนงจัมเปอรของ CMOS วาถูกตอง ถา
มี

164-MemorySize Error ปริมาณหนวยความจำเปลี่ยนไป นับต้ังแตท่ีมีการบูต
คร้ังลาสุด (มีการใสเพิม่หรือถอดหนวยความจำ)

กดปุม F1 เพื่อบันทึกการเปลี่ยนแปลงหนวยความจำ

164-MemorySize Error การต้ังคาหนวยความจำไมถูกตอง 1. รันยูทลิิตีการต้ังคาคอมพิวเตอรหรือยูทิลิตีของ
Windows

2. โปรดตรวจสอบวามกีารติดตั้งโมดูลหนวยความ
จำอยางถูกตอง

3. หากมีการใชหนวยความจำของผูผลิตรายอื่น
โปรดทดสอบโดยใชเฉพาะหนวยความจำเฉพาะ
ของ HP

4. ตรวจสอบวาประเภทโมดลูหนวยความจำถกูตอง

201-Memory Error RAM ลมเหลว 1. รันยูทลิิตีการต้ังคาคอมพิวเตอรหรือยูทิลิตีของ
Windows

2. ตรวจสอบวาโมดูลหนวยความจำไดรับการตดิ
ตั้งอยางถูกตอง

3. ตรวจสอบวาประเภทโมดลูหนวยความจำถกูตอง

4. ถอดและเปลี่ยนโมดูลหนวยความจำที่ถูกระบุวา
บกพรอง

5. หากขอผิดพลาดยังคงอยูหลังจากเปลี่ยนหนวย
ความจำแลว ใหเปล่ียนเมนบอรด

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

โมดูลหนวยความจำในซ็อกเก็ตหนวยความจำที่ระบุใน
ขอความแสดงขอผิดพลาดขาดขอมลู SPD หรือเขา
กับชิปเซ็ตไมได

1. ตรวจสอบวาประเภทโมดลูหนวยความจำถกูตอง

2. ลองใชซ็อกเก็ตหนวยความจำอืน่

3. เปลี่ยน DIMM โดยใชโมดูลท่ีเขากันกับ
มาตรฐาน SPD

214-DIMM Configuration Warning การกำหนดคา DIMM ท่ีติดตั้ง ไมเหมาะสม จัดเรียง DIMM ใหมเพื่อใหแตละแชนเนลมีจำนวน
หนวยความจำเทาน้ัน

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

โมดูลหนวยความจำที่เพิ่งติดตั้งสนับสนุนการแกไขขอ
ผิดพลาดของหนวยความจำ ECC

1. ถาเพ่ิงมีการเพิ่มหนวยความจำ ใหถอดออกและ
ดูวาปญหายังคงอยูหรือไม

2. ตรวจสอบเอกสารที่มาพรอมกับผลิตภัณฑ เพ่ือดู
ขอมูลเก่ียวกับการสนับสนุนหนวยความจำ

301-Keyboard Error แปนพิมพไมทำงาน 1. ตอแปนพมิพเขากบัคอมพิวเตอรใหมอีกครั้งใน
ขณะปดเคร่ือง

2. ตรวจสอบวาชองเสียบมีการหักงอหรือสูญหาย
หรือไม

3. ตรวจดูวาไมมีการกดแปนอักษรใดๆ

4. เปลี่ยนแปนพิมพ

ตาราง A-1  รหัสตัวเลขและขอความ (ตอ)
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ขอความท่ีแผงควบคุม คำอธิบาย วิธีปฏิบัติท่ีแนะนำ

303-Keyboard Controller Error คอนโทรลเลอรแปนพิมพของบอรด I/O 1. ตอแปนพมิพเขากบัคอมพิวเตอรใหมอีกครั้งใน
ขณะปดเคร่ือง

2. เปลี่ยนเมนบอรด

304-Keyboard or System Unit Error แปนพิมพไมทำงาน 1. ตอแปนพมิพเขากบัคอมพิวเตอรใหมอีกครั้งใน
ขณะปดเคร่ือง

2. ตรวจดูวาไมมีการกดแปนอักษรใดๆ

3. เปลี่ยนแปนพิมพ

4. เปลี่ยนเมนบอรด

404-Parallel Port Address Conflict Detected ท้ังพอรตภายในและภายนอกถูกกำหนดใหกับพอรต
ขนาน X

1. ถอดการดเอ็กซแพนชันของพอรตขนานท้ังหมด

2. ลบคาใน CMOS (โปรดดูภาคผนวก B การ
รักษาความปลอดภยัดวยรหัสผานและการรีเซ็ต
CMOS)

3. ตั้งคาของการดเอ็กซแพนชันใหมและ/หรือรัน
โปรแกรมการตั้งคาคอมพิวเตอร

410-Audio Interrupt Conflict แอดเดรสของ IRQ ขัดแยงกับอุปกรณอื่น เขาสูยูทิลิตีการต้ังคาคอมพิวเตอร แลวรีเซ็ต IRO ใน
Advanced > Onboard Devices

411-Network Interface Card Interrupt Conflict แอดเดรสของ IRQ ขัดแยงกับอุปกรณอื่น เขาสูยูทิลิตีการต้ังคาคอมพิวเตอร แลวรีเซ็ต IRO ใน
Advanced > Onboard Devices

501-Display Adapter Failure คอนโทรลเลอรจอภาพกราฟก 1. ตอการดแสดงผลใหม (ถามี)

2. ลบคาใน CMOS (โปรดดูภาคผนวก B การ
รักษาความปลอดภยัดวยรหัสผานและการรีเซ็ต
CMOS)

3. ตรวจสอบวาตอและเปดหนาจอแลว

4. เปลี่ยนการดแสดงผล (ถาเปนไปได)

510-Splash Screen Image Corrupted อิมเมจของ Flash Screen มีขอผิดพลาด แฟลช ROM ของระบบอีกครั้ง ดวยอิมเมจลาสุดของ
BIOS

511-CPU, CPUA, or CPUB Fan not Detected พัดลม CPU ไมถูกเช่ือมตอหรืออาจทำงานผิดพลาด 1. ติดต้ังพัดลม CPU ใหมอีกครั้ง

2. ติดตั้งสายเคเบิลสำหรับพัดลมใหมอีกคร้ัง

3. เปลี่ยนพัดลม CPU

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

พัดลมท่ีตัวโครง ตัวโครงดานหลัง หรือตัวโครงดาน
หนา ไมไดถูกเช่ือมตอ หรืออาจทำงานไมถูกตอง

1. พัดลมท่ีตัวโครง ตัวโครงดานหลัง หรือตัวโครง
ดานหนาใหมอีกคร้ัง

2. ติดตั้งสายเคเบิลสำหรับพัดลมใหมอีกคร้ัง

3. เปลี่ยนพัดลมท่ีตัวโครง ตัวโครงดานหลัง หรือตัว
โครงดานหนา

514-CPU or Chassis Fan not Detected พัดลม CPU หรือพัดลมท่ีตัวโครงไมถูกเช่ือมตอหรือ
อาจทำงานผิดพลาด

1. ติดต้ังพัดลม CPU หรือพัดลมท่ีตัวโครงใหมอีก
คร้ัง

2. ติดตั้งสายเคเบิลสำหรับพัดลมใหมอีกคร้ัง

3. เปลี่ยนพัดลม CPU หรือพัดลมที่ตัวโครง

601-Diskette Controller Error วงจรคอนโทรลเลอรดิสเก็ตตหรอืวงจรฟลอปป
ไดรฟไมถูกตอง

1. รันยูทิลิตีการต้ังคาคอมพิวเตอร

2. ตรวจสอบและ/หรือเปล่ียนสายเคเบิล

ตาราง A-1  รหัสตัวเลขและขอความ (ตอ)
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3. ลบคาใน CMOS (โปรดดูภาคผนวก B การ
รักษาความปลอดภัยดวยรหัสผานและการรีเซ็ต
CMOS)

4. เปลี่ยนดิสเก็ตตไดรฟ

5. เปลี่ยนเมนบอรด

605-Diskette Drive Type Error ประเภทของไดรฟไมตรงกัน 1. รันยูทลิิตีการต้ังคาคอมพิวเตอร

2. ถอดอุปกรณคอนโทรลเลอรของดิสเก็ตตอื่นๆ
ทั้งหมด (เทปไดรฟ)

3. ลบคาใน CMOS (โปรดดูภาคผนวก B การ
รักษาความปลอดภัยดวยรหัสผานและการรีเซ็ต
CMOS)

610-External Storage Device Failure ไมไดตอเทปไดรฟภายนอก ติดต้ังเทปไดรฟใหม หรือกด F1 และใหระบบต้ังคา
ใหมโดยไมตองใชไดรฟ

611-Primary Floppy Port Address
Assignment Conflict

เกิดขอผิดพลาดในการตั้งคา รันยูทลิิตีการต้ังคาคอมพิวเตอร แลวตรวจสอบการ
กำหนดคาใน Advanced > Onboard Devices

660-Display cache is detected unreliable แคชแสดงผลของคอนโทรลเลอรกราฟกทำงานไมถูก
ตองและจะถูกปดลง

เปล่ียนเมนบอรดหากการดอยลงของกราฟกอยูในข้ัน
ต่ำ

912-Computer Cover Has Been Removed
Since Last System Startup

ฝาครอบคอมพิวเตอรถกูถอดออกต้ังแตการเริ่มตน
ระบบครั้งท่ีแลว

ไมตองดำเนินการใดๆ

917-Front Audio Not Connected ตัวควบคุมเสียงดานหนาไมไดเชือ่มตอหรือติดตั้งเขา
กับเมนบอรด

เชื่อมตอหรือเปล่ียนตัวควบคุมเสียงดานหนา

918-Front USB Not Connected ตัวควบคุม USB ดานหนาไมไดเชื่อมตอหรือติดตั้งเขา
กับเมนบอรด

เชื่อมตอหรือเปล่ียนตัวควบคุม USB ดานหนา

922-ระบบน้ีสนับสนุนเฉพาะการด SDVO/ADD2
ในสล็อต x16

ชองเสียบ SDVO/PCI บนเมนบอรดมีรูปลักษณภาย
นอกเหมือนกับชองเสียบ PCI Express x16 แต
แพลตฟอรมไมสนับสนุนการใชการด PCI Express
แบบคอนเวนชันนอลหรือการดเคาโครงพิเศษ (หรือ
reversed-layout) ADD2

แพลตฟอรมสนับสนนุเฉพาะการใชงานเคาโครงปกติ
(หรือ non-reversed) การดอะแดปเตอร ADD2
(Advanced Digital Display SDVO) ใสเขากับชอง
เสียบ SDVO (Serial Digital Video Output) ที่
แพลตฟอรมของเมนบอรด การด ADD2 ถูกนำมาใช
เพื่อใหความสามารถมอนิเตอรเอนกประสงคกับคอน
โทรลเลอรกราฟกภายใน

1151-Serial PortA Address Conflict Detected พอรตอนกุรมท้ังภายในและภายนอกกำหนดไวท่ี
COM1

1. ถอดการดเอ็กซแพนชันของพอรตอนุกรมท้ัง
หมด

2. ลบคาใน CMOS (โปรดดูภาคผนวก B การ
รักษาความปลอดภัยดวยรหัสผานและการรีเซ็ต
CMOS)

3. ตั้งคาการดเอ็กซแพนชันใหมและ/หรือรันยูทิลิตี
การตัง้คาคอมพิวเตอรหรือยูทิลิตีของ
Windows

1152-Serial Port B Address Conflict Detected พอรตอนุกรมท้ังภายในและภายนอกถูกกำหนดไวท่ี
COM2

1. ถอดการดเอ็กซแพนชันของพอรตอนุกรมท้ัง
หมด

2. ลบคาใน CMOS (โปรดดูภาคผนวก B การ
รักษาความปลอดภัยดวยรหัสผานและการรีเซ็ต
CMOS)

3. ตั้งคาการดเอ็กซแพนชันใหมและ/หรือรันยูทิลิตี
การตัง้คาคอมพิวเตอรหรือยูทิลิตีของ
Windows
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1155-Serial Port Address Conflict Detected พอรตอนุกรมท้ังภายในและภายนอกถูกกำหนดไวท่ี
IRQ เดียวกัน

1. ถอดการดเอ็กซแพนชันของพอรตอนุกรมท้ัง
หมด

2. ลบคาใน CMOS (โปรดดูภาคผนวก B การ
รักษาความปลอดภยัดวยรหัสผานและการรีเซ็ต
CMOS)

3. ตั้งคาการดเอ็กซแพนชันใหมและ/หรือรันยูทิลิตี
การตัง้คาคอมพิวเตอรหรือยูทิลิตีของ
Windows

1201-System Audio Address Conflict
Detected

แอดเดรสดีไวซ IRQ ขัดแยงกับอุปกรณอื่น เขาสูยูทิลิตีการต้ังคาคอมพิวเตอร แลวรีเซ็ต IRO ใน
Advanced > Onboard Devices

1202-MIDI Port Address Conflict Detected แอดเดรสดีไวซ IRQ ขัดแยงกับอุปกรณอื่น เขาสูยูทิลิตีการต้ังคาคอมพิวเตอร แลวรีเซ็ต IRO ใน
Advanced > Onboard Devices

1203-Game Port Address Conflict Detected แอดเดรสดีไวซ IRQ ขัดแยงกับอุปกรณอื่น เขาสูยูทิลิตีการต้ังคาคอมพิวเตอร แลวรีเซ็ต IRO ใน
Advanced > Onboard Devices

1720-SMART Hard Drive detects imminent
failure

ฮารดไดรฟกำลังจะหยุดทำงาน (ฮารดไดรฟบางตัวมี
เฟรมแวรแพตชที่จะแกไขขอความแสดงขอผิดพลาด
ท่ีไมถูกตอง)

1. ตรวจสอบวาฮารดไดรฟใหขอความแสดงขอผิด
พลาดท่ีถูกตอง เขาสูยูทิลิตีการต้ังคา
คอมพิวเตอร แลวรันโปรแกรมการทดสอบ
ระบบปองกันไดรฟใต Storage > DPS Self-
test

2. ใชเฟรมแวรแพตช หากมี (เลือกใชไดจาก
http://www.hp.com/support)

3. ทำขอมูลสำรองแลวเปล่ียนฮารดไดรฟ

1796-SATA Cabling Error อุปกรณ SATA ไมไดรับการเชื่อมตออยางเหมาะสม
เพื่อประสิทธิภาพการทำงานสูงสุด จะตองใชชองเสียบ
SATA 0 และ SATA 1 กอน SATA 4 และ SATA
5

สำหรับอุปกรณเดียว ใหใช SATA 0 สำหรับสอง
อุปกรณ ใหใช SATA 0 และ SATA 1 สำหรับสาม
อุปกรณ ใหใช SATA 0, SATA 1 และ SATA 5

1797-SATA Drivelock is not supported in
RAID mode

Drivelock ถูกเปดใชบนฮารดไดรฟ SATA หน่ึงหรือ
หลายตัว และไมสามารถเขาถงึไดในขณะท่ีกำลัง
กำหนดคาระบบสำหรับโหมด RAID

ถอดอุปกรณ Drivelocked SATA ออกกอนหรือปด
การทำงานของคุณสมบัติ Drivelock ในการปดการทำ
งานของคุณสมบัต ิDrivelock ใหเขาสูยูทิลิตีการต้ังคา
คอมพิวเตอร เปล่ียน Storage > Storage
Options > SATA Emulation เปน IDE และ
เลือก File > Save Changes and Exit เขาสู ยูทิลิ
ตีการต้ังคาคอมพิวเตอรอีกคร้ัง และเลือก Security
> Drivelock สำหรับอุปกรณ SATA ท่ีใช
Drivelock ไดแตละอุปกรณ ดูใหแนใจวาไดต้ัง
Drivelock เปน Disabled สุดทาย ใหเปล่ียน
Storage > Storage Options > SATA
Emulation กลับเปน RAID และเลือก File > Save
Changes and Exit

1801-Microcode Patch Error ROM BIOS ไมสนับสนุนโปรเซสเซอร 1. อัพเกรด BIOS ใหเปนเวอรชันท่ีเหมาะสม

2. เปลี่ยนโปรเซสเซอร

Invalid Electronic Serial Number อิเล็กทรอนิกสซีเรียลนัมเบอรผิด 1. รันยูทิลิตีการต้ังคาคอมพิวเตอร หากยูทิลิตีการ
ตั้งคามีขอมูลในชองท่ีปรากฏแลว หรือไม
อนุญาตใหใสซีเรียลนัมเบอร ใหดาวนโหลดไฟล
ปฏิบัติการจาก http://www.hp.com

2. รันยูทิลิตีการต้ังคาคอมพิวเตอร และใสซีเรียล
นัมเบอรใน Security, System ID และบันทึก
การเปลี่ยนแปลง

Memory Parity Error Parity RAM ไมทำงาน รันยูทิลิตีการต้ังคาคอมพิวเตอรและยูทิลิตีการวินิจฉัย
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การดแสดงผลจากผูผลิตรายอื่นอาจจะทำใหเกิดปญหา
ได

ถอดการดแสดงผลจากผูผลิตรายอื่นออก จากน้ันดูวา
ยังมีปญหาหรือไม

Network Server Mode Active and No
Keyboard Attached

แปนพิมพไมทำงานในขณะที่เปดใชงาน Network
Server Mode

1. ตอแปนพมิพเขากบัคอมพิวเตอรใหมอีกครั้งใน
ขณะปดเคร่ือง

2. ตรวจสอบวาชองเสียบมีการหักงอหรือสูญหาย
หรือไม

3. ตรวจดูวาไมมีการกดแปนอักษรใดๆ

4. เปลี่ยนแปนพิมพ

Parity Check 2. Parity RAM ไมทำงาน

การดแสดงผลจากผูผลิตรายอื่นอาจจะทำใหเกิดปญหา
ได

รันยูทลิิตีการต้ังคาคอมพิวเตอรและยูทิลิตีการวินิจฉัย

ถอดการดแสดงผลจากผูผลิตรายอื่นออก จากน้ันดูวา
ยังมีปญหาหรือไม

System will not boot without fan พัดลม CPU ไมไดรับการตดิต้ังหรือเชื่อมตอในโครง
เคร่ือง VSFF

1. ถอดฝาครอบคอมพิวเตอรออก กดปุมเพาเวอร
แลวดูวาพัดลมท่ีโปรเซสเซอรหมุนหรือไม หาก
พัดลมท่ีโปรเซสเซอรไมหมุน ใหตรวจดูวา ได
เสียบสายเคเบิลของพัดลมเขากับเฮดเดอรบน
เมนบอรดเรียบรอยแลวใชหรือไม ดูใหแนใจวา
ติดตั้งตัวระบายความรอนเขาท่ีดีแลว

2. หากเสียบปล๊ักพัดลมแลวและติดต้ังตัวระบาย
ความรอนอยางเหมาะสมแลว แตพัดลมยังไม
หมุน ใหเปลี่ยนสวนประกอบพัดลมของตัว
ระบายความรอน
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การแปลความหมายของสัญญาณไฟวินิจฉัยการ POST ท่ีแผงดานหนาและ
รหัสเสียง

หัวขอนี้กลาวถึงรหัสสัญญาณไฟที่แผงดานหนารวมทั้งรหัสเสียงที่อาจเกิดขึ้นกอนหรือระหวางกระบวนการ POST ซ่ึงไมจำ
เปนตองมีรหัสหมายเลขหรือขอความแสดงขอผิดพลาดเขามาเกี่ยวของ

คำเตือน! เม่ือตอสายไฟกับเครื่องคอมพิวเตอร แหลงจายไฟจะมีแรงดันไฟฟาสำหรับเมนบอรดอยูตลอดเวลา เพ่ือ
ลดความเสี่ยงที่จะไดรับบาดเจ็บจากไฟฟาช็อต และ/หรือพ้ืนผิวที่รอน คุณควรตรวจดูใหแนใจวา ไดถอดปล๊ักไฟแลว
และปลอยใหสวนประกอบภายในของระบบเย็นกอนจะสัมผัส

ใหมองไปที่ไฟ LED ในเมนบอรด ในกรณีที่ไฟ LED สวาง แสดงวาเมนบอรดยังคงมีกระแสไฟอยู ปดเครื่อง
คอมพิวเตอรและถอดปลั๊กออกกอนจะดำเนินการตอ

หมายเหตุ หากไฟที่แปนพิมพ PS/2 กะพริบ ใหตรวจดูไฟกะพริบบนแผงดานหนาของคอมพิวเตอร และดูราย
ละเอียดในตารางดานลางน้ีเพ่ือระบุรหัสสัญญาณไฟที่แผงดานหนา

ควรปฏิบัติตามการดำเนินการที่แนะนำในตารางดานลางนี้

ไฟสัญญาณวินิจฉัยและรหัสเสียงไมไดมีอยูในทุกรุน

ตาราง A-2  สัญญาณไฟที่แผงดานหนาและรหัสเสียง

การทำงาน สัญญาณเสียง สาเหตุท่ีเปนไปได การดำเนินการท่ีแนะนำ

ไฟสถานะเปดเคร่ืองสีเขียวสวาง ไมมี เคร่ืองคอมพิวเตอรเปดอยู ไมมี

ไฟสถานะเปดเคร่ืองสีเขียวกะพริบ
ทุก 2 วินาที

ไมมี คอมพิวเตอรอยูในโหมดพักการ
ทำงานของ RAM (บางรุนเทา
นั้น) หรือโหมดพักการทำงาน
ปกติ

ไมจำเปน กดปุมใดๆ หรือขยับเมาส เพื่อใหคอมพิวเตอรทำ
งานอีกครั้ง

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 2
ครั้งทุกๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
ครั้งท่ี 5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

2 ระบบปองกันความรอนของ
โปรเซสเซอรถูกเปดใชงาน:

พัดลมอาจถูกปดกั้นหรือไมทำ
งาน

หรือ

ตัวระบายความรอน/พัดลมไม
ไดเชื่อมตอกับโปรเซสเซอร
อยางถูกตอง

1. ตรวจสอบวาชองระบายอากาศไมไดถูกปดก้ันและพัด
ลมระบายความรอนทำงาน

2. เปดฝาครอบ กดปุมเพาเวอร แลวดูวาพัดลมที่
โปรเซสเซอรหมุนหรือไม หากพัดลมท่ีโปรเซสเซอร
ไมหมุน ใหตรวจดูวา ไดเสียบสายเคเบิลของพัดลมเขา
กับเฮดเดอรบนเมนบอรดเรียบรอยแลวใชหรือไม

3. หากพัดลมถูกตออยูแลวแตไมหมุน ใหเปล่ียนช้ินสวน
ตัวระบายความรอน/พัดลม

4. ติดตอผูใหบริการหรือตัวแทนจำหนายท่ีไดรับอนุญาต

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 3
ครั้งทุกๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
ครั้งท่ี 5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

3 ไมไดติดต้ังโปรเซสเซอร (ไมได
บงช้ีวาโปรเซสเซอรบกพรอง)

1. ตรวจดูวามีโปรเซสเซอรอยูในเครื่องหรือไม

2. ติดต้ังโปรเซสเซอรอีกคร้ัง
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การทำงาน สัญญาณเสียง สาเหตุท่ีเปนไปได การดำเนินการท่ีแนะนำ

ไฟสถานะเปดเครื่องสีแดงกะพริบ 4
ครั้งทุกๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเน่ือง
ครั้งท่ี 5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

4 แหลงจายไฟไมทำงาน (แหลง
จายไฟโอเวอรโหลด)

1. เปดฝาครอบ แลวตรวจดูวาสายเคเบิลของแหลงจาย
ไฟแบบ 4 หรือ 6 สาย เช่ือมตอเขากับชองเสียบบน
เมนบอรดแลว

2. ตรวจสอบวาอุปกรณเปนสาเหตุใหเกิดปญหาน้ีหรือไม
โดยถอดอุปกรณท้ังหมดที่เช่ือมตออยู (เชน
ฮารดไดรฟ ดิสเก็ตตไดรฟ หรือไดรฟออปติคัล และ
การดเอ็กซแพนชัน) เปดเครื่องคอมพิวเตอร หาก
คอมพิวเตอรเขาสู POST ใหปดเคร่ือง แลวตอ
อุปกรณกลับคืนครั้งละชิ้น และทำตามข้ันตอนดังกลาว
ซ้ำอีกคร้ังจนกวาเครื่องจะไมทำงาน เปล่ียนอุปกรณที่
เปนสาเหตุใหเคร่ืองไมทำงาน ตออุปกรณกลับคืนคร้ัง
ละชิ้น เพื่อใหแนใจวาอุปกรณท้ังหมดทำงานเปนปกติ

3. เปลี่ยนแหลงจายไฟ

4. เปลี่ยนเมนบอรด

ไฟสถานะเปดเครื่องสีแดงกะพริบ 5
ครั้งทุกๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเน่ือง
ครั้งท่ี 5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

5 หนวยความจำการแสดงผลเกิด
ขอผิดพลาด

ขอควรระวัง ในการหลีกเล่ียงความเสียหายของ
DIMM หรือเมนบอรด คุณตองถอดปลั๊ก
คอมพิวเตอรกอนที่จะพยายามตอ ติดต้ัง หรือนำ
โมดูล DIMM ออก

1. ใส DIMM ใหมอีกคร้ัง

2. เปลี่ยน DIMM ทีละช้ิน เพื่อแยกโมดูลท่ีมีขอผิดพลาด
ออก

3. ใชหนวยความจำของ HP แทนหนวยความจำของผู
ผลิตรายอื่น

4. เปลี่ยนเมนบอรด

ไฟสถานะเปดเครื่องสีแดงกะพริบ 6
ครั้งทุกๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเน่ือง
ครั้งท่ี 5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

6 การแสดงผลมีขอผิดพลาด สำหรับระบบท่ีใชการดแสดงผล:

1. ติดตั้งการดแสดงผลใหม

2. เปลี่ยนการดแสดงผล

3. เปลี่ยนเมนบอรด

สำหรับระบบท่ีใชกราฟกภายใน ใหเปลี่ยนเมนบอรด

ไฟสถานะเปดเครื่องสีแดงกะพริบ 7
ครั้งทุกๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเน่ือง
ครั้งท่ี 5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

7 เมนบอรดขัดของ (ROM ตรวจ
พบการขัดของกอนการแสดง
ผล)

เปลี่ยนเมนบอรด

ไฟสถานะเปดเครื่องสีแดงกะพริบ 8
ครั้งทุกๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเน่ือง
ครั้งท่ี 5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

8 ROM ไมถูกตอง เน่ืองจากการ
ตรวจสอบผลรวมผิดพลาด

1. แฟลช ROM ของระบบอีกครั้ง ดวยอิมเมจลาสุดของ
BIOS โปรดดูรายละเอียดเพ่ิมเติมในหัวขอ “โหมดกู
คืนฉุกเฉินบล็อคการบูต” ใน คูมือการจัดการ
เดสกทอป ใน แผนซีด ีDocumentation and
Diagnostics

2. เปลี่ยนเมนบอรด

ตาราง A-2  สัญญาณไฟที่แผงดานหนาและรหัสเสียง (ตอ)
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การทำงาน สัญญาณเสียง สาเหตุท่ีเปนไปได การดำเนินการท่ีแนะนำ

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 9
ครั้งทุกๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
ครั้งท่ี 5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

9 เคร่ืองเปดอยู แตไมสามารถบูต
ระบบ

1. ตรวจสอบสวิตชเลือกระดับแรงดันไฟฟาที่ดานหลัง
ของแหลงจายไฟ (ในคอมพิวเตอรบางรุน) วาอยูใน
ตำแหนงของระดับแรงดันไฟฟาท่ีถูกตอง การตั้งคา
แรงดันไฟฟาท่ีเหมาะสมขึ้นอยูกับประเทศ/พ้ืนที่ท่ีคุณ
อาศัยอยู

2. เปลี่ยนเมนบอรด

3. เปลี่ยนโปรเซสเซอร

ไฟสถานะเปดเคร่ืองสีแดงกะพริบ 10
ครั้งทุกๆ วินาที จากนั้นเวน 2 วินาที
เสียงเตือนหยุดหลังจากดังตอเนื่อง
ครั้งท่ี 5 แตไฟ LED จะสวางจนกวา
ปญหาจะไดรับการแกไข

10 การดเสริมมีขอบกพรอง 1. ตรวจสอบการดเสริมแตละชิ้น โดยถอดการดออกทีละ
ชิ้น (ในกรณีท่ีติดต้ังการดหลายชิ้น) จากน้ันใหเปด
เคร่ือง เพ่ือดูวายังมีขอบกพรองหรือไม

2. ถาพบการดท่ีผิดปกติ ใหถอดออกและเปลี่ยนอันใหม

3. เปลี่ยนเมนบอรด

ไมสามารถเปดเคร่ืองคอมพิวเตอร
และไฟแสดงสถานะที่แผงดานหนา
ของคอมพิวเตอรไมกะพริบ

ไมมี ไมสามารถเริ่มตนการทำงาน
ของระบบ

กดปุมเพาเวอรคางไวไมถึง 4 วินาที หากไฟสถานะ
ฮารดไดรฟเปล่ียนเปนสีเขียว แสดงวาปุมเพาเวอรทำงาน
เปนปกติ ใหปฏิบัติตามขั้นตอนตอไปน้ี:

1. ตรวจสอบสวิตชเลือกระดับแรงดันไฟฟา (ในบางรุน)
ที่ดานหลังของแหลงจายไฟวาอยูในตำแหนงของ
ระดับแรงดันไฟฟาที่ถูกตอง การต้ังคาแรงดันไฟฟาที่
เหมาะสมข้ึนอยูกับประเทศ/พ้ืนท่ีท่ีคุณอาศัยอยู

2. เปลี่ยนเมนบอรด

หรือ

กดปุมเพาเวอรคางไวไมถึง 4 วินาที หากไฟสถานะ
ฮารดไดรฟไมเปล่ียนเปนสีเขียว ใหปฏิบัติดังน้ี:

1. ตรวจดูวาอุปกรณเสียบปล๊ักเขากับเตารับไฟฟาอยาง
ถูกตอง

2. เปดฝาครอบ แลวตรวจดูวาตวัควบคุมปุม
เพาเวอรเชื่อม ตอเขากับเมนบอรดอยางถูกตอง

3. ตรวจดูวาสายแหลงจายไฟท้ัง 2 สายเชื่อมตอเขากับ
เมนบอรดอยางถูกตอง

4. ตรวจดูวาไฟ 5V_aux บนเมนบอรดสวางหรือไม ถา
ไฟสวาง ใหเปล่ียนตัวควบคุมปุมเพาเวอร หากปญหา
ยังคงอยู ใหเปลี่ยนเมนบอรด

5. ถาไฟ 5V_aux บนเมนบอรดดับ ใหถอดการดเอ็กซ
แพนชันออกทีละการดจนกวาไฟ 5V_aux บน
เมนบอรดจะสวาง หากปญหายังคงอยู ใหเปล่ียนแหลง
จายไฟ

ตาราง A-2  สัญญาณไฟที่แผงดานหนาและรหัสเสียง (ตอ)
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B การรักษาความปลอดภัยดวยรหัสผานและการรีเซ็ต
CMOS

คอมพิวเตอรนี้รองรับการใชคุณสมบัติรักษาความปลอดภัยดวยรหัสผาน ซึ่งสามารถกำหนดไดในเมนูของ ยูทิลิตีการตั้งคา
คอมพิวเตอร

คอมพิวเตอรนี้รองรับการใชคุณสมบัติรักษาความปลอดภัยดวยรหัสผานสองคุณสมบัต ิซึ่งสามารถกำหนดไดในเมนูของยูทิลิ
ตีการตั้งคาคอมพิวเตอร รหัสผานสำหรับการตั้งคา และรหัสผานเมื่อเปดเคร่ือง หากคุณกำหนดเฉพาะ รหัสผานสำหรับการตั้ง
คา ผูใชทุกรายจะสามารถเขาถึงขอมูลทั้งหมดในระบบ ยกเวนการกำหนดคาในยูทิลิตีการตั้งคาคอมพิวเตอร และหากคุณใช
เฉพาะรหัสผานเมื่อเปดเคร่ือง ผูใชจะตองปอนรหัสผานเพื่อเขาใชยูทิลิตีการตั้งคาคอมพิวเตอร หากคุณกำหนดรหัสผานทั้ง
สองชนิดไว จะมีเพียงรหัสผานสำหรับการตั้งคาเทานั้นที่ใชในการเขาสูยูทิลิตีการต้ังคาคอมพิวเตอรได

หากคุณกำหนดรหัสผานทั้งสองชนิด รหัสผานสำหรับการตั้งคาจะใชแทนรหัสผานเมื่อเปดเครื่องในการล็อกเขาสูระบบได
คุณสมบัติดังกลาวถือวาเปนประโยชนสำหรับผูดูแลระบบ

หากคุณลืมรหัสผานสำหรับคอมพิวเตอรของคุณ มี 2 วิธีที่จะใชยกเลิกรหัสผานเพื่อใหคุณสามารถเขาใชขอมูลไดอีกคร้ัง:

● การรีเซ็ตจัมเปอรรหัสผาน

● การเรียกคืนการต้ังคาคอมพิวเตอรใหเปนคาดีฟอลตจากโรงงาน

ขอควรระวัง การกดปุม CMOS จะรีเซ็ตคา CMOS กลับเปนคาดีฟอลตที่ตั้งมาจากโรงงาน สิ่งสำคัญคือการสำรอง
ขอมูลใน CMOS ของคอมพิวเตอรกอนที่จะรีเซ็ต ในกรณีที่อาจตองการใชในภายหลัง การสำรองขอมูลทำไดโดยเขา
สูยูทิลิตีการต้ังคาคอมพิวเตอร โปรดดูขอมูลเพิ่มเติมเกี่ยวกับการสำรองขอมูลการตั้งคา CMOS ที่ คูมือยูทิลิตีการตั้ง
คาคอมพิวเตอร (F10) ใน แผนซีดี Documentation and Diagnostics
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การรีเซ็ตจัมเปอรรหัสผาน
ในการตัดการทำงานของรหัสผานเม่ือเปดเคร่ืองหรือรหัสผานสำหรับการตั้งคา ใหปฏิบัติตามขั้นตอนตอไปนี้:

1. ปดระบบปฏิบัติการตามขั้นตอนที่ถูกตอง จากน้ันปดเคร่ืองคอมพิวเตอรและอุปกรณภายนอกอื่นๆ ถอดสายไฟออกจาก
เตารับไฟฟา

2. เมื่อถอดสายไฟแลว ใหกดปุมเพาเวอรอีกคร้ังเพ่ือถายกระแสไฟที่ยังหลงเหลืออยูในคอมพิวเตอร

คำเตือน! เพ่ือลดความเสี่ยงตอการบาดเจ็บจากไฟฟาช็อตและ/หรือพ้ืนผิวที่รอน ควรถอดสายไฟออกจากเตา
รับที่ผนัง และใหสวนประกอบภายในของเครื่องคอมพิวเตอรเย็นลงกอนที่จะสัมผัส

ขอควรระวัง เม่ือตอสายไฟกับเครื่องคอมพิวเตอร แหลงจายไฟจะมีแรงดันไฟฟาสำหรับเมนบอรดอยูตลอด
เวลา แมวาเครื่องจะปดอยูก็ตาม หากคุณไมถอดสายไฟออก อาจเกิดความเสียหายแกระบบได

ไฟฟาสถิตอาจทำใหสวนประกอบอิเล็กทรอนิกสของคอมพิวเตอรหรือการดเสริมชำรุดเสียหายได กอนที่จะเริ่ม
ตนกระบวนการเหลานี ้โปรดตรวจสอบวาคุณไดคายประจุไฟฟาสถิตดวยการสัมผัสวัตถุที่เปนโลหะและมีการ
ลงกราวด โปรดดูรายละเอียดเพิ่มเติมใน คูมืออางอิงฮารดแวร บน แผนซีด ีDocumentation and
Diagnostics

3. ถอดฝาครอบคอมพิวเตอรหรือแผงดานขาง

4. หาตำแหนงเฮดเดอรและจัมเปอร

หมายเหตุ จัมเปอรรหัสผานจะเปนสีเขียว ทำใหระบุไดงาย หากตองการคำแนะนำในการหาตำแหนงของ
จัมเปอรรหัสผานและสวนประกอบอื่นๆ ของเมนบอรด โปรดดูที่  แผนผังชิ้นสวนพรอมภาพประกอบ (IPM)
สำหรับระบบของคุณ โดยคุณสามารถดาวนโหลด IPM ไดจาก http://www.hp.com/support

5. ถอดจัมเปอรออกจาก pin 1 และ 2 แลววางจัมเปอรที่ pin 1 หรือ 2 แตอยาวางที่ทั้งคู ทั้งน้ีเพื่อปองกันการสูญหาย

6. เปลี่ยนฝาครอบคอมพิวเตอรหรือแผงปดเคร่ืองคอมพิวเตอร

7. ตออุปกรณภายนอก

8. เสียบปล๊ักและเปดเครื่องคอมพิวเตอร ใหระบบปฏิบัติการเริ่มทำงาน วิธีนี้เปนการยกเลิกรหัสผานปจจุบันและเลิกใชงาน
คุณสมบัติรหัสผาน

9. เพื่อที่จะตั้งรหัสผานใหม ใหทำซ้ำข้ันตอน 1 ถึง 4 เปลี่ยนจัมเปอรรหัสผานบน pin 1 และ 2 จากนั้นใหทำซ้ำ 6 ถึง 8
แลวตั้งรหัสผานใหมในการตั้งคาคอมพิวเตอร โปรดดูคำแนะนำเก่ียวกับการต้ังคาคอมพิวเตอรที ่คูมือยูทิลิตีการตั้งคา
คอมพิวเตอร (F10) ใน แผนซีดี Documentation and Diagnostics
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การลบคาและการรีเซ็ต CMOS
หนวยความจำการตั้งคาของคอมพิวเตอร (CMOS) เปนที่เก็บขอมูลเกี่ยวกับการตั้งคาคอมพิวเตอร

การใชยูทิลิตีการตั้งคาคอมพิวเตอรเพื่อรีเซ็ต CMOS
การใชยูทิลิตีการตั้งคาคอมพิวเตอรเพ่ือรีเซ็ต CMOS ยังเปนการลบรหัสผานปองกันการเปดเคร่ืองและรหัสผานสำหรับการ
ตั้งคา ในการรีเซ็ต CMOS โดยใชยูทิลิตีการต้ังคาคอมพิวเตอร ขั้นแรกคุณตองเขาสูเมนู ยูทิลิตีการต้ังคาคอมพิวเตอร

เมื่อขอความ Computer Setup ปรากฏขึ้นที่มุมขวาลางของหนาจอ ใหกดปุม F10 กด Enter หากตองการขามหนาจอเริ่ม
ตน

หมายเหตุ หากคุณไมไดกดปุม F10ในขณะที่ขอความนั้นปรากฏอยู คุณจะตองปดคอมพิวเตอร กอนเปดข้ึนมา
ใหมเพื่อเขาสูยูทิลิตีนี้

เมนูของยูทิลิตีการตั้งคาคอมพิวเตอรจะแสดงตัวเลือก 5 หัวขอ: File, Storage, Security, Power และ Advanced

ในการรีเซ็ต CMOS ใหเปนคาดีฟอลตที่มาจากโรงงาน ใหกำหนดเวลาและวันที่กอน จากนั้นใชปุม ลูกศร หรือปุม แท็บ เพ่ือ
เลือก File > Default Setup > Restore Factory Settings as Defaults แลวเลือก Apply Defaults and
Exit จากเมน ูFile ซึ่งจะเปนการรีเซ็ตการตั้งคาที่แกไขได ซ่ึงรวมถึงลำดับการบูตและการต้ังคาอ่ืนๆ ที่มาจากโรงงาน แตจะ
ไมมีการคนหาฮารดแวรใหม

โปรดดูคำแนะนำเพ่ิมเติมเกี่ยวกับการตั้งรหัสผานใหมที่ คูมือการจัดการเดสกทอป ใน แผนซีดี Documentation and
Diagnostics สำหรับขอมูลเพ่ิมเติมเกี่ยวกับการใชยูทิลิตีการตั้งคาคอมพิวเตอร โปรดดู คูมือยูทิลิตีการตั้งคาคอมพิวเตอร
(F10) ใน แผนซีดี Documentation and Diagnostics

การใชปุม CMOS
ปุม CMOS จะรีซ็ตแตไมไดลบรหัสผานปองกันการเปดเคร่ืองและรหัสผานสำหรับการต้ังคา

1. ปดเคร่ืองคอมพิวเตอรและอุปกรณภายนอกทั้งหมด แลวถอดสายไฟออกจากเตารับไฟฟา

2. ถอดสายแปนพิมพ จอภาพ และอุปกรณภายนอกอื่นๆ ออกจากคอมพิวเตอร

คำเตือน! เพ่ือลดความเสี่ยงตอการบาดเจ็บจากไฟฟาช็อตและ/หรือพ้ืนผิวที่รอน ควรถอดสายไฟออกจากเตา
รับที่ผนัง และใหสวนประกอบภายในของเครื่องคอมพิวเตอรเย็นลงกอนที่จะสัมผัส

ขอควรระวัง เม่ือตอสายไฟกับเครื่องคอมพิวเตอร แหลงจายไฟจะมีแรงดันไฟฟาสำหรับเมนบอรดอยูตลอด
เวลา แมวาเครื่องจะปดอยูก็ตาม หากคุณไมถอดสายไฟออก อาจเกิดความเสียหายแกระบบได

ไฟฟาสถิตอาจทำใหสวนประกอบอิเล็กทรอนิกสของคอมพิวเตอรหรือการดเสริมชำรุดเสียหายได กอนที่จะเริ่ม
ตนกระบวนการเหลานี ้โปรดตรวจสอบวาคุณไดคายประจุไฟฟาสถิตดวยการสัมผัสวัตถุที่เปนโลหะและมีการ
ลงกราวด โปรดดูรายละเอียดเพ่ิมเติมใน คูมืออางอิงฮารดแวร บน แผนซีดี Documentation and
Diagnostics

3. ถอดฝาครอบคอมพิวเตอรหรือแผงดานขาง

ขอควรระวัง การกดปุม CMOS จะรีเซ็ตคา CMOS กลับเปนคาดีฟอลตที่ตั้งมาจากโรงงาน สิ่งสำคัญคือการ
สำรองขอมูลใน CMOS ของคอมพิวเตอรกอนที่จะรีเซ็ต ในกรณีที่อาจตองการใชในภายหลัง การสำรองขอมูล
ทำไดโดยเขาสูยูทิลิตีการตั้งคาคอมพิวเตอร โปรดดูขอมูลเพิ่มเติมเก่ียวกับการสำรองขอมูลการตั้งคา CMOS
ที่ คูมือยูทิลิตีการต้ังคาคอมพิวเตอร (F10) ใน แผนซีดี Documentation and Diagnostics
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4. หาตำแหนงปุม CMOS แลวกดคางไว 5 วินาที

หมายเหตุ ตรวจดูใหแนใจวาไดถอดสายไฟออกจากเตาเสียบที่ผนังแลว ปุม CMOS จะไมสามารถลบคาใน
CMOS ได หากยังเสียบสายไฟอยู

ภาพ B-1  ปุม CMOS

หมายเหตุ หากตองการคำแนะนำในการหาตำแหนงของปุม CMOS และสวนประกอบอื่นๆ ของเมนบอรด
โปรดดูที่แผนผังชิ้นสวนพรอมภาพประกอบ (IPM) สำหรับระบบของคุณ

5. เปลี่ยนฝาครอบคอมพิวเตอรหรือแผงปดเคร่ืองคอมพิวเตอร

6. ตออุปกรณภายนอก

7. เสียบปล๊ักและเปดเครื่องคอมพิวเตอร

หมายเหตุ หลังจากที่คุณลบคาใน CMOS และรีบูตระบบ จะปรากฏขอความแสดงขอผิดพลาด POST ซึ่ง
ระบุวามีการเปลี่ยนแปลงคาคอนฟเกอเรชัน ใชยูทิลิตีการตั้งคาคอมพิวเตอรเพ่ือรีเซ็ตการตั้งคาพิเศษใดๆ ของ
ระบบพรอมกับการตั้งวันที่และเวลา

สำหรับขอมูลเพ่ิมเติมเกี่ยวกับการใชยูทิลิตีการตั้งคาคอมพิวเตอร โปรดดู คูมือยูทิลิตีการต้ังคาคอมพิวเตอร (F10) ใน แผน
ซีดี Documentation and Diagnostics
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C ระบบปองกันไดรฟ (DPS)

ระบบปองกันไดรฟ (DPS) เปนเคร่ืองมือในการวินิจฉัยที่มีอยูในฮารดไดรฟท่ีติดตั้งในเครื่องคอมพิวเตอรบางรุน DPS ได
รับการออกแบบมาเพื่อชวยวินิจฉัยปญหาที่อาจสงผลใหตองมีการเปลี่ยนฮารดไดรฟโดยไมอยูในเง่ือนไขการรับประกัน

เมื่อคอมพิวเตอรเหลานี้ถูกสรางขึ้น ฮารดไดรฟที่ติดตั้งไวทุกตัวจะไดรับการทดสอบโดยใชระบบ DPS และจะมีการบันทึก
ขอมูลที่สำคัญไวอยางถาวรในไดรฟน้ันๆ และทุกคร้ังที่รัน DPS ผลการทดสอบจะถูกบันทึกลงในฮารดไดรฟ ผูใหบริการของ
คุณสามารถใชขอมูลนี้เพ่ือชวยวินิจฉัยปญหาที่ทำใหคุณตองรันซอฟตแวร DPS

การรัน DPS จะไมมีผลตอโปรแกรมหรือขอมูลที่เก็บอยูในฮารดไดรฟ ขอมูลการทดสอบจะอยูในเฟรมแวรของฮารดไดรฟ
และสามารถรันไดแมวาคอมพิวเตอรจะไมสามารถบูตเขาสูระบบปฏิบัติการ เวลาที่ใชในการรันการทดสอบจะขึ้นอยูกับผูผลิต
และขนาดของฮารดไดรฟ แตโดยทั่วไปแลว การทดสอบจะใชเวลาประมาณ 2 นาทีตอกิกะไบต

คุณสามารถใช DPS เมื่อสงสัยวาฮารดไดรฟจะมีปญหา หากคอมพิวเตอรรายงานขอความ SMART Hard Drive Detect
Imminent Failure คุณไมจำเปนตองรัน DPS แตใหสำรองขอมูลไวในฮารดไดรฟและติดตอผูใหบริการเพ่ือขอ
เปล่ียนไดรฟ

THWW 61



การเขาใช DPS จากโปรแกรมการตั้งคาคอมพิวเตอร
เมื่อคอมพิวเตอรไมเร่ิมตนอยางถูกตอง คุณควรใชโปรแกรมการตั้งคาคอมพิวเตอร เพ่ือเขาใชโปรแกรม DPS เมื่อตองการ
เขาใช DPS ใหปฏิบัติตามขั้นตอนตอไปนี้:

1. เปดหรือเริ่มตนระบบคอมพิวเตอรใหม

2. เมื่อขอความ F10 Setup ปรากฏขึ้นที่มุมขวาลางของหนาจอ ใหกดปุม F10

หมายเหตุ หากคุณไมไดกดปุม F10ในขณะที่ขอความนั้นปรากฏอยู คุณจะตองปดคอมพิวเตอร กอนเปดขึ้น
มาใหมเพื่อเขาสูยูทิลิตีนี้

เมนูของยูทิลิตีการตั้งคาคอมพิวเตอรจะแสดงตัวเลือก 5 หัวขอ: File, Storage, Security, Power และ
Advanced

3. เลือก Storage > DPS Self-Test

หนาจอจะแสดงรายชื่อฮารดไดรฟที่สามารถใช DPS ที่ติดตั้งอยูในระบบคอมพิวเตอร

หมายเหตุ หากไมมีฮารดไดรฟที่สามารถใช DPS ติดตั้งไว ตัวเลือก DPS Self-Test จะไมปรากฏบนหนา
จอ

4. เลือกฮารดไดรฟที่ตองการทดสอบและปฏิบัติตามคำแนะนำบนหนาจอเพ่ือดำเนินการทดสอบใหเสร็จสมบูรณ

เมื่อการทดสอบเสร็จสมบูรณ ขอความใดขอความหนึ่งตอไปน้ีจะปรากฏข้ึน:

● Test Succeeded. Completion Code 0.

● Test Aborted. Completion Code 1 or 2.

● Test Failed. Drive Replacement Recommended. Completion Code 3 through 14.

หากการทดสอบลมเหลว คุณควรบันทึกและรายงานรหัสขอผิดพลาดไปยังผูใหบริการเพ่ือขอรับความชวยเหลือในการวินิจฉยั
ปญหา
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